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Figure 1 - Identification of parts: version with housing.

N, Parts N. Parts
T fCover 20 [Electronic board Tocator pins
2 |Base 21 | JP2 current draw limiter jumper (versions with housing
3 [Indicator Tights (LED) only): see “Description of Jumpsj-rs on p,'a\ge 11
- — 22 |Battery connector: versions with housing only
7 | Closing screw (parked position)
- 23 |ANTLTE-02 adapter cable
8 |Base mounting holes (4)
- 24 | Adapter cable nut
9 |Cover hinge 5 i TS I
10 [ Antenna cable hole 22 :ttlegrfate amenna.t\)/lersmns WT . ouksmg only
11 |2700 mAh rechargeable battery (optional): versions with ole for antenna cable on metal bracket
housing only 27 |Metal bracket
12 |Wall tamper device 28 |ANTLTE-02, multi-band antenna with 2 m cable and
13 [Hole for wall tamper device fixing SMA connector (optlohal)
29 |Multi-band antenna with 2 m cable and MMCX
14 {SIM holder
15 | PC-LINK connector connector
e B e Desaion o _ 30 |Electronic board mounting holes (4)
rogramming jumpers: see “Description of jumpers” on 31 [Ehemet port
page 11
17 |USB port
18 [Tamper contact
19 |Terminal boards
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Figure 2 Identification of parts: a) version with housing; b) ANTLTE-02, multi-band antenna with 2 m cable and SMA

connector (optional).
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These instructions apply to communicators with firmware revision 2.00 and above.
Hereby, Bentel Security S.r.l. declares that the radio equipment type BGS-210, BGS-220, B3G-220/EU and BLE-320 are in compliance with Directive 2014/
53/EU.
The full text of the EU declaration of conformity is available at the following internet address: www.bentelsecurity.com/dc.
*) The BGS-220 and B3G-220/EU product models have been certified by IMQ/A to be compliant with standards:
EN 50136-1:2012 and EN 50136 2:2013 for alarm transmission system performance SP2 (D2, M2, T2, S0, 10) for vocal/text alarm messages and SP4 (D3,
M3, T4, S2, 13) for digital messages;
EN 50131-10, Security Grading 2;
TO31;
EN 50130-5 Class I.
*) The BLE-320 product model has been certified by IMQ/A to be compliant with standards:
EN 50136-1:2012 and EN 50136 2:2013 for alarm transmission system performance SP2 (D2, M2, T2, S0, 10) for vocal/text alarm messages and DP3 (D3,
M3, T4, S2, 13) for digital messages;
EN 50131-10, Security Grading 2;
TO31;
EN 50130-5 Class I.

To ensure conformity with the T031 standard, the Communicator must be connected to the panel with terminals LI and the following events and messages/
codes must be set: INTRUSION ALARM, TAMPER ALARM, MAIN POWER FAILURE, BATTERY FAILURE, HOLD-UP, ARMING, DISARMING,
INHIBITED ZONE AND ISOLATED ZONE.

The communicator is certified IMQ-SECURITY SYSTEMS if powered by the panel and without backup battery.

Installation of these systems must be carried out strictly in accordance with the instructions described in this manual and in compliance with the local laws
and bylaws in force. The above mentioned devices have been designed and made to the highest standards of quality and performance. The manufacturer
recommends that the installed system should be completely tested at least once a month. Bentel Security shall not be responsible for damage arising from
improper installation or maintenance by unauthorized personnel. Bentel Security reserves the right to change the technical specifications of this product
without prior notice.

RECYCLING INFORMATION
Bentel Security recommends that customers dispose of their used equipment (panels, detectors, sirens, and other devices) in an environmentally sound
manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials. For specific information see
www.bentelsecurity.com/index.php?o=environmental.

WASTE ELECTRICAL AND ELECTRONIC EQUIPMENT (WEEE) DIRECTIVE

In the European Union, this label indicates that this product should NOT be disposed of with household waste. It should be deposited at an
ﬁ appropriate facility to enable recovery and recycling. For specific information see www.bentelsecurity.com/index.php?o0=environmental.
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INTRODUCTION

The devices made by BGS-210, BGS-220, B3G-220 and BLE320 series are cellular communicators that provide a backup PSTN
line and are able to transmit vocal (BGS-220, B3G-220 and BLE320 only) and SMS alarm messages to the end user, and digital
messages to supported Sur-Gard System receivers. By means of the ConnectAlarm app running on Android and iOS mobile
devices, you can manage the communicator, and the control panel wired to it, and view the communicator's and control panel's
events. The BLE-320 model has an Ethernet interface that may be used as main communication channel, or for cellular commu-
nication channel backup (dual-path), for digital message transmission to supported Sur-Gard System receivers. The Ethernet in-
terface enables an alternative and faster way to program the communicator. The following versions are available:

BGS-210: communicator board with 2G module in plastic housing.

BGS-220: communicator board with 2G module in plastic housing.

B3G-220/EU: communicator board with 3G module in plastic housing, for the Europe Union market.

BLE-320: dual-path communicator board with LTE module and Ethernet interface, in plastic housing, for the Europe Union
market.

YV VYV

For special installation requirements, a remote outdoors antenna ANTLTE-10 with 10 m cable is available.

The information in this manual is common to all versions. The term “communicator” refers to functions shared by all versions. In-
formation relating to specific models is highlighted with reference to the respective code.

=" Some of the topics found in this manual may not be relevant to your version: refer to “General specifications” on page 6 to see
the features of your version. References to Ethernet apply to BLE-320 only.

This manual provides instructions for programming and using the communicator.

Safety instructions

Read the safety information before you install the equipment.

A Important: This equipment must be installed by a skilled person only. A skilled person is an installer with appropriate
technical training. The installer must be aware of potential hazards during installation and measures available to
minimize risks to the installer and other people.

»  Before you install this equipment, disconnect all power sources (for example mains, battery, and telephone line) connected to
the alarm panel.

» Install the equipment indoors in a non-hazardous environment where the following conditions are met:
- Pollution degree - Maximum 2
- Over voltages - Category Il

> Internal wiring must be routed to prevent strain on wire and terminal connections, loose terminal connections, and damage to
conductor insulation.

» Instruct the user that there are no user serviceable parts in this equipment. All equipment must be serviced by a skilled
person

IS These instructions must be used in areas together with the panel's installation manual. Follow all instructions given in this
manual.

BGS-210/BGS-220/B3G-220/BLE-320 5



General specifications

Model

BLE-320

-

Boxed

Mobile phone standard?®

Dual Band

Quad Band

Dual path

Simulates a PSTN line.

Detects the absence of a PSTN line and automatically switches to cellular network
Manages and reports incoming and outgoing phone calls

Cellular signal strength indicator

Terminals, programmable as open-collector outputs or inputs

T1, T2 and T3 terminals

Remote management of inputs and outputs through the ConnectAlarm app
Protection against overvoltage on the phone line

Integrated antenna

External antenna with magnetic base

SMS message transmission to mobile phone and ConnectAlarm app for
communicator's events

Voice message transmission over cellular network for communicator’s events
Conversion of Contact ID and SIA messages of control panel connected to LI
terminals, to SMS, and push notifications to ConnectAlarm app
Conversion of Contact ID and SIA messages of control panel connected to LI
terminals, to voice messages over cellular network

Contact ID and SIA message transmission to PSTN and IP Sur-Gard System I, 11, I1I,
IV and 5 receivers

Options programmable by PC

Communicator blocked when PINs are at default (EN50136-2)

Programmable text messages (each at most 70 characters long)

Text messages for each input

Status text messages

Periodic text message

Programmable telephone numbers (16 digit max.)

Phone numbers for sending SMS messages

Phone numbers for transmitting events to Sur-Gard receivers

Phone numbers for remote output activation

Remote output activation via call recognition, or SMS

Residual credit monitoring for prepaid SIM cards

Panel Transmission Monitoring (PTM)

Tamper detection

PC-LINK port

Type A USB connector (Host and device)

Ethernet interface

Programming with USB key

Advanced diagnostics and event log exporting by means USB key

Loading custom default via USB key

Firmware programming and updates, both local and remote

Alarm event transmission via cellular network

Alarm event transmission via Ethernet channel

Priority programmable with PSTN/Cellular
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Model oo |§ ]

B2|8|@

[aa]

Two-way communications with cellphone Y [Y [Y|Y
Optional backup battery N Y [Y [Y
Current limitator (JP2 jumper) N Y [Y |Y
Alarm panel management and status monitoring YO[Y [Y [Y
Y |Y [Y |Y

Jamming detection

a. Check that the SIM operator in use supports 2G, 3G, or LTE standard, depending on the

model, in the area where the communicator is installed.
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Technical specifications

The power for the communicator is supplied by the panel to which it is connected (10.7 V to 27.6 V) or by an external power supply
which also recharges an optional backup battery, if necessary. The sole purpose of the battery is to supply power in case of failure
of the primary power source (8 hours stand-by).

I When the communicator is powered by the battery, ONLY communicator events are transmitted.

The primary power and (optional) battery voltages are supervised.
The power supply for communicators with housing must be SELV, with power limited to 1 A.

BGS-210
Version BGS-220 BLE-320
B3G-220/EU

Input Voltage from 10.7 to 27.6 V=== from 10.7 to 27.6 V===
Standby average current @ 13.8 V===, without 90 mA 110 mA
battery (not including outputs)
Average current consumption per hour 100 mA 120 mA
Maximum current draw in current limited mode @ 230 mA 230 mA
13.8 V=== (versions with housing only, not including
outputs)
Maximum current draw @ 13.8 V=== (not including 450 mA 470 mA
outputs)
Maximum current on open-collector output 100 mA 100 mA
Maximum loop resistance of line between the device 1 Kohm 1 Kohm
connected in series on LI
Maximum number of parallel devices connected on 1 1
LI
Environmental class I I
Operating temperature from -10 to +40°C from -10 to +40°C
Humidity from 0 to 95% from 0 to 95%
Dimensions (LxHxD) 101x186x41 mm 101x186x41 mm
Weight 2509 2509

Table 1 - Technical specifications.

Operating frequency (MHz)
Version
GSMI/GPRS/EDGE UMTS/HSPA LTE
BGS-210, BGS-220 850/90071800/1900 N/A N/A
B3G-220/EU 900/1800 900/2100 N/A
BLE-320 900/1800 900/1800/2100 700/800/900/1800/2100/2600

Table 2 — Operating frequency.
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Maximum radio-frequency power

Class 4 (2 W) @ 850/900 MHz, GSM

Class 1 (1 W) @ 1800/1900 MHz, GSM
Class E2 (0.5 W) @ 850/900 MHz, EDGE

Class E2 (0.4 W) @ 1800/1900 MHz, EDGE
Class 3 (0.25 W) @ 850/900/1900/2100 MHz, WCDMA
Class 3 (0.2 W) @700/800/850/900/1800/1700/1900/2100/2600 MHz, LTE

Table 3 — Maximum radio-frequency power.

Interface type between SPT (Supervised Proprietary interface
Premises Transceiver) and AS (Alarm System)
ATS (Alarm Transmission System) SINGLE PATH DUAL PATH
. SP4 for digital | SP2 forvocal/ | DP3for digital | SP2 for vocal/

Alarm Transmission System performance messages text messages messages text messages
Average transmission time D3(20s) D2 (60 s) D3 (20s) D2 (60 s)
Maximum transmission time M3 (60 s) M2 (120 s) M3 (60 s) M2 (120 s)
Reporting time T4 (180 s) T2 (25h) T4 (180 s) T2 (25 h)
Substitution security S2 SO S2 SO
Information security 13 10 13 10

Table 4 — EN 50136-1:2012 and EN 50136-2:2013 specifications.

BGS-210/BGS-220/B3G-220/BLE-320




Identification of parts

Numbers given in bold in this manual refer to the main parts of the communicator shown in figure 1 and 2, and the table on page 2.
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Description of jumpers

<!

Jumper Position Description

PST [00) Reserved (leave open).

USB 00 The communicator behaves as a USB Device (factory setting).
[~ ) The communicator behaves as a USB Host.

TMP 00 Anti-tamper function enabled (factory setting).
[— ) Anti-tamper function disabled.

UFC 00 Future use.

JP2 No limit to communicator current draw (factory setting).

ea0) [ Cam

Communicator current draw limited to 230 mA.
A Backup battery required!

Table 5 — Description of jumpers.

BGS-210/BGS-220/B3G-220/BLE-320
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Description of indicator lights

The communicator is equipped with indicator lights (LED) which report the following information.

I During initialisation, all LEDs light up for less than 1 second. During factory settings restore, LEDs -|||| and l are off while

®)
LEDs A and (A) are on.

LED Colour Name

Description

Greenlyellow Cellular signal strength

Type of network for packet service (see table 7).
Cellular signal strength (see table 8).
Type of communication (see table 9).

Red Fault See table 10.
Yellow Line status On: the communicator has switched to the simulated PSTN.
((}é?) Slow flashing: line occupied, voice message transmission.
G Green Cellular network status Technical assistance LED.

ACT |Green USB

On: Host.

Off: Device.

Slow flashing: error.
Fast flashing: activity.

Table 6 - Indicator LED.

LED Colour

Type of network for packet service

Green 2G

-|||| Yellow 3G

.l |Greenand Yelow?  |LTE

Table 7 — Type of network for packet service.

a. Green and yellow colours may not be visible on the communicator’s cover, for the communicators with housing: you

may see just the yellow colour.

Cellular signal strength

Off Off No cellular signal.
Off On Low cellular signal strength.
On On High cellular signal strength.

Table 8 - Cellular signal strength.
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|||| al Type of communication
1

connected to the communicator, if any.

Slow flashing Slow flashing Initialisation: the LEDs flash until the communicator receives a cellular signal.

Fast flashing Off SMS incoming: the LED flashes for a few seconds.

Slow flashing Off Remote session: the LED may flash for a few seconds after the end of the session.
Off Slow flashing Voice call: reports the communicator's voice call, NOT the voice calls of the panel

Table 9 - Type of communication.
Fault LED

This LED is usually off. It flashes to indicate a fault. The communicator monitors faults in the order given in table 10. The most

important fault status is indicated, with the respective number of flashes of the RED LED, as shown in the following table.

Priorities Description Flashes

1 (HIGH) [Firmware problem (incorrect firmware): invalid data in external flash memory. 1

2 Power problems: the power voltage falls below 10 V. 2

3 Battery problems: the battery voltage falls below 3.4 V. 3

4 Factory PIN: the EN50136 option is enabled and the User, Installer or Level 4 PIN is that set in the 4
factory.

5 Radio module fault: the microprocessor is unable to communicate with the radio module during the 5
initialisation sequence.

6 SIM problem: SIM card PIN check enabled. 6

7 Cellular network problem: the radio module is unable to connect to the cellular network. 7

8 Mobile data network problem: the radio module is unable to connect to the mobile data network. 8

9 Future use. 9

10 IP 1 receiver problem: initialisation failure; supervision failure; no ACK. 10

11 (LOW) | IP 2 receiver problem: initialisation failure; supervision failure; no ACK. 11

Table 10 - Fault LED.

BGS-210/BGS-220/B3G-220/BLE-320 13



Description of terminals

Terminals T1, T2, T3, T4, T5 and T6 can be programmed as described below.

» Open-collector outputs: the outputs can be activated by programmed events (automatic activation), SMS or by call
recognition (remote activation); see “Activating outputs” on page 32 for details. The maximum current draw per output is

100 mA.
» Inputs: the inputs send SMS or voice messages when activated.

Terminals BGS-220/B3G-220/BLE-320 BGS-210

= Earth: this terminal must be connected to the electrical system earth to protect the device against overvoltage on
the telephone line and to satisfy safety requirements.

LI Internal telephone line: these terminals must be connected to the panel or other communications terminal.

LE External telephone line: these terminals may be connected to the PSTN line.

T1 Factory setting: output, PSTN fault. N/A

T2 Factory setting: output, no cellular network. N/A

T3 Factory setting: input, interconnection present. N/A

T4 Factory setting: output, tamper. Factory setting: output, PSTN fault.

T5 Factory setting: output, cellular fault. Factory setting: output, no cellular network.

Té6 Factory setting: output, Jamming. Factory setting: output, tamper.

Vel Ground: power negative and common terminals for the open-collector outputs.

+V Power supplied by panel 10.7 to 27.6 V===: make sure it is protected and current limited (Limited Power Source —
LPS) in conformity with EN 60950-1:2006 standard).
To connect the power, use cable of no more than 3 meters length, and 0.75 mm? cross-section.
For shorter cables, use appropriate cross-sections.

14 Universal Cellular/Ethernet Communicators



Installation

A\ Connect the power supply and telephone circuits after the communicator is mounted and connected to the building
ground circuit.
Before fitting or removing the SIM card, make sure the communicator is NOT powered up.

IS" The communicator shall be installed only by a QUALIFIED TECHNICIAN, indoors, in a safe, dry position, away from RF
transmitting equipment.
Position the communicator for good cellular signal coverage.
DO NOT route any cable over the circuit board.
Do not use power cables which are more than 3 m long.

BGS-210/BGS-220/B3G-220/BLE-320 15



Installing the version with housing

The version with housing must be mounted to a wall with screws and plugs (not included) as described below and shown in figure 3.

=

2
A

> w

o

Open the communicator: insert a flathead screwdriver into holes 33 and prise the cover off the base, then slide the cover
upwards to separate it from the base completely.
If you wish to fit the optional battery LIB2A6, read the following steps, otherwise go to step 7.

Risk of explosion if battery is replaced by an incorrect type. Dispose of used battery according to the manufacturer's
instructions. Batteries are to be replaced by service persons only.

Remove the electronic board: compress hooks 34 to release the board from the base.
Fit the battery as shown in figure 3.

Make sure the silicon/graphite grommet 12 is in place.

Restore the board: first insert its left side under hooks 31, then press the right side gently down until it snaps into place.
Connect the battery to connector 22 after having powered the communicator up with terminals +V and /7.

The communicator will NOT operate correctly if it is powered only by the battery when first switched on.

Mark the positions for the 8 base mounting holes and the position of hole 13 for the wall-tamper device.
Drill holes in the marked positions.

Take care not to damage any wires or tubes running inside the wall.
Route the ducted cables in the wall through openings 35 or break out the tabs 32 to route the exposed cables into the

housing.
Mount the base to the wall.

. Continue with the installation as described in paragraph “Power and testing” on page 18.

For dual-path version only, break the knock-out 35 if you connected a Ethernet cable: break section 35a, and 35b, according
to the Ethernet cable type you are using, as shown in figure 3a and 3b.

Close the communicator: remove screw 7 from its parked position; slightly tilt the cover; approach the top of the cover to the
base; slide the cover downwards; press the bottom of the cover against the base until it snaps into place; if necessary, secure
the cover to the base with screw 7 in hole 36.

16
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Figure 3— Installing the communicator with housing.
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Power and testing

1.

Fit the SIM card into SIM holder 14 as shown by the arrows, with its contacts facing downwards.

IS The operation related to the communicator's Ethernet channel works properly without inserting SIM card also.

w

7.

For the communicator to work properly, you must use a 32 kB or better SIM card.
You must disable the SIM card's PIN before fitting it into the communicator.
Disable call transfer on the SIM card.

Set the jumpers as required by your application (see “Description of jumpers” on page 11).
Make the connections to terminal block 19 as described in paragraph “Connection example” on page 20.
For the dual-path version only, connect the Ethernet cable to the connector 31, if required.

A @
Power up the communicator: all LEDs will light up for 1 second, then LEDs and A will stay on for a few seconds,

after which LED A will flash 4 times to indicate that the User, Installer and Level 4 Installer PINs are the factory default
settings.

Use the Console to change the PINs, as described in chapter “PC PROGRAMMING” on page 39, and enable the
communicator.

Check the signal strength: make sure that at least LED «Il turns on; if the LED -l||| is on, the signal strength is excellent.

If LEDs +1l and -|||| are off, the signal is NOT strong enough: reposition the communicator or try installing the optional antenna
ANTLTE-02 (versions with housing only) or ANTLTE-10, as described in the respective paragraphs.

=

The communicator complies with the EN 50136-2 standard and, for this reason, its access codes have to be set at the first
power up, by means of the Console, in this way the communicator functionality will be enabled.

If you do not need the compliance with the EN 50136-2 and like to start working without the Console, please proceed as follows.

1.

4,

Make sure that the communicator settings are at default (read “Restore Factory Settings” on page 42 to restore the default
settings).

Insert the PST jumper.

Connect the communicator to the power.

A @
Wait until the and A LEDs switch off, then remove the PST jumper.

Installing the antenna ANTLTE-02

The ANTLTE-02 has greater gain than the communicator's integrated antenna in the version with housing, and can be mounted
indoors within 2 meters of the communicator, to improve cellular reception, as described below and shown in figure 4.

I Position the antenna to optimise cellular reception.

1
2
3
4,
5
6

Break the tab closing hole 37.

Remove the electronic board: compress hooks 34 to release the board from the base.

Remove nut 24 and washer 38 from adapter cable 23.

Fit adapter cable connector 39 into hole 37, the secure it with nut 24: washer 38 is not required.

Connect adapter cable connector 40 to connector 43.

Restore the board: first insert its left side under hooks 31, then press the right side gently down until it snaps into place.

IS Make sure the adapter cable is routed as shown in figure 4.

7.

Secure metal bracket 28 as desired with holes 41.

18
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8. Route antenna connector 42 through hole 26 in the bracket.
9. Position antenna 29 on the bracket so that its magnetic base adheres to its surface.
10. Connect antenna connector 42 to adapter cable connector 39.

28—

31 ao & |
PR RRSIReHed @
ol JUL Jo

Figure 4 — Installing the antenna ANTLTE-02.
Installing the antenna ANTLTE-10

The ANTLTE-10 has greater gain than the communicator's integrated antenna in the version with housing, and can be mounted
outdoors within 10 m of the communicator, to improve the mobile reception.

Refer to the installation instructions included with the ANTLTE-10 antenna.

Tamper detection

The version with housing of the communicator is equipped with a device which detects when the cover is opened and the communicator
is removed from the wall (tampering).

Tampering is reported by the Tamper event, to which actions can be associated (activate outputs, send voice, SMS or digital message)
with the Console: the factory setting is that terminal T4 on BGS-220/B3G-220/BLE-320 or terminal T6 on BGS-210 is floating (it is nor-
mally connected to earth) in the event of tamper.

Once you have programmed the function, close the cover and power up the communicator.

After initialisation, open the cover and check that the communicator actually executes the actions programmed for the tamper detection.

BGS-210/BGS-220/B3G-220/BLE-320 19



Connection example

A\ Incorrect connections may result in FTC fault or improper operation. Inspect wiring and ensure connections are
correct before applying power. DO NOT route any wiring over circuit boards; maintain at least 1” (24.5 mm)
separation. A minimum 1/4” (6.4 mm) separation must be maintained at all points between Power Limited wiring and

all other Not-Power Limited wiring.

I To ensure conformity with EN 50136-2, the communicator must be connected and programmed as described in paragraph
“Conformity with EN 50136-2:2013" on page 77.

(B -~
TR T1|12|T3|T4| 75 |76 | A 4V
| |
R o
E|

Al
‘ ‘ "||

LE L1

1 G |

| [F

RI-11

Figure 5— Connection example: A) Communicator; B) disconnect the telephone line before servicing the unit; C) example
connection of terminal T1 programmed as open-collector output; D) power 10.7 - 27.6 V===, E) terminals T1, T2, T3,
T4, T5 and T6 can be programmed as open-collector outputs or input lines; F) burglar alarm panel; G) connection to
telephone line (PSTN); H) ground connection (obligatory).
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GENERAL DESCRIPTION

This communicator can communicate with central stations, and send both SMS and voice messages, via the cellular network; it
can also simulate a PSTN line in case of malfunction (phone line failure) or substitute of one completely in areas with cellular cov-
erage in which PSTN calls are not available.

I SIA and CID messages may NOT be understood by the PSTN receivers due to distortion on the cellular network. It is

recommended to forward SIA and CID messages to IP receivers instead, when the PSTN line fails, as indicated in
“Phonebook” on page 43: see the option IP Receiver on GSM Path.

I Due to the nature of the cellular network, the communicator may be used solely for its intended purpose and NOT as a modem
for sending faxes or data or for remote assistance services.

It can report alarms over the cellular network, for reliable, fast communications with central stations equipped with compatible Sur-
Gard System receiver. The performance of the communicator depends largely on the coverage, and it should not be installed with-
out having first checked the position of the antenna for best reception (the LED ,j| at least must be on).

The dual path versions have an Ethernet interface that can be used as primary or backup communication channel with the Sur-
Gard receivers. The Ethernet interface also enable an alternate and faster way of communication with panels and the console soft-
ware.

The communicator has terminals (T) which can be programmed as inputs or outputs (see “Inputs/Outputs” on page 52).
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Access levels

This paragraph describes how to access the communicators functions, according to EN50136 standard.

If the EN50136 option is enabled (factory default; see “Options” on page 46), the communicator can handle all four levels of user
access to its functions. The access levels are as follows.

» Level 1: access to function display, indications (LEDs used to report faults, cellular status, and PSTN status) and messages
(SMS, voice, etc.) available to all users without PIN; this level does not allow any programming.

» Level 2 (normal user): access to communicator status information (e.g. use of the Console to display the status page,
programming options and events buffer). This level requires a PIN. Factory setting: 000000.

» Level 3 (installer): access to configuration functions including addition, removal and replacement of components and other
operations which directly or indirectly affect the communicator's functions (e.g. upload/download programming options with
the console, display Status page and events buffer). This level requires a PIN. Factory setting: 111111.

I |f the EN50136 option is enabled, the installer must be authorised by the normal user.

» Level 4 (level 4 installer): access to firmware updates and Status page display. This level requires a PIN.
Factory setting: 222222.

I The level 4 installer must be authorised by the installer.
To ensure compliance with EN 50136-2: 2013, the PINs for access to levels 2, 3 and 4 are 6 digit numbers.
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USB connector functions

The communicator has a USB A connector to enable it to work as a device, to connect it to a PC, or as host, to handle a USB key
(see “Description of jumpers” on page 11).

To connect the communicator to a PC, you need a USB cable with A connectors at each end (hub cable).

The USB interface has the following characteristics.

YVVVVYYYVY

Conformity: USB 2.0.

Full speed data: 12 Mbit/s.

Max. length of cable: 5 m.

Max. current in host mode: 500 mA.
Vout in Host mode: 5 V nominal.
USB key file system: FAT32.

USB device

The USB interface will be an alternative to communications with the RS232 port (PC-Link). It will have the same functions as the
RS232 and will be used with the Console to:

>
>
>
>

update the firmware (level 4 installer only);

upload/download communicator options and audio files (installer only; the normal user can only upload);
upload the communicator's events buffer (installer and normal user only);

check the communicator's status in real time (all users).

USB Host

Allows you to use a USB key for the following operations:

YVVVVY

firmware updates;

load custom default;

upload/download settings and audio files;

export the events buffer;

export the communicator's debug buffer (technical service only).

These functions are available only if the EN50136 option is disabled.
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Power Monitor

The device can be powered in the following ways:

1. by the burglar alarm panel, equipped with a backup battery, in which case the communicator must operate at voltages in the
range 10.7to 27.6 V.

2. byanexternal 12 V power supply, in which case the power supply must recharge the communicator's optional backup battery
(8 hours of operation following primary power outage).

In both cases, the battery ensures that the communicator is still operational in case of power failure.
The power and battery voltages are supervised so that the communicator can report the following events:

> Power fault/restore event.
»  Power fault/restore message (voice / SMS / message to the IP receivers).

Since the device can operate with or without an external backup battery (without input current limitation), the following two scenarios
correspond to a power failure.

Power voltage check

The power voltage will be supervised to detect problems. The voltage is checked every 100 ms. The following conditions apply to
the device without external backup battery:

Power problem event: when the voltage drops below 10 V (the PSTN interface is turned off).

Power problem restore: when the voltage rises above 12 V.

Start Energy Save mode: when the voltage drops below 9 V (the USB interface and the radio module are turned off).
Quit Energy Save mode: when the voltage rises above 10.7 V.

YV VYV

I=" When the communicator is in Energy Save mode, the current draw does not exceed 175 mA. The maximum current

consumption, in Energy Save mode with battery connected and no action in progress is around 70 mA and is less than 150 mA
during voice calls.

Battery voltage check

The battery voltage will be supervised to check for any faults and that the battery itself is present. The voltage is checked every
100 ms. The value is processed (mean of values) to eliminate peaks. The following conditions apply to the device with external
backup battery:

Battery problem event: when the battery voltage drops below 3.4 V.
Battery problem restore: when the battery voltage rises above 3.7 V.
Start Energy Save mode: when the battery voltage drops below 3.2 V.
Quit Energy Save mode: when the battery voltage rises above 3.4 V.
Battery disconnected event: when the battery voltage drops below 2.0 V.
Battery disconnected restore: when the battery voltage rises above 2.0 V.
Battery overload event: when the battery voltage rises above 4.4 V.
Battery overcharge restore: when the battery voltage drops below 4.3 V.

VVVVVYYYVYY

IS" When the communicator is powered ONLY by the battery, you can NOT use the USB port.
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Internal events

Along with the external events (panel events decoded with the Contact ID or SIA protocol on the simulated PSTN line), the com-
municator can send voice messages, SMS messages, and Contact ID or SIA messages for the events listed in the Table 11, as
indicated in “Communicator” on page 59.

Event

Description

Input 1 Event

This occurs when terminal T1 is programmed as an input and the conditions for its
activation occur (see “Inputs/Outputs” on page 52).

Input 2 Event

Like Input 1 Event but for terminal T2.

Input 3 Event

Like Input 1 Event but for terminal T3.

Input 4 Event Like Input 1 Event but for terminal T4.
Input 5 Event Like Input 1 Event but for terminal T5.
Input 6 Event Like Input 1 Event but for terminal T6.

Input 1 Restore

This occurs when terminal T1 is programmed as an input, and returns to standby status
(see “Inputs/Outputs” on page 52).

Input 2 Restore

Like Input 1 Restore but for terminal T2.

Input 3 Restore

Like Input 1 Restore but for terminal T3.sono

Input 4 Restore

Like Input 1 Restore but for terminal T4.

Input 5 Restore

Like Input 1 Restore but for terminal T5.

Input 6 Restore

Like Input 1 Restore but for terminal T6.

Mains Fault

Happens when the power voltage (terminal +V) drops below 10 V.

Mains Fault Restore

Happens when the power voltage (terminal +V) rises above 12 V.

Battery Fault

Happens when the battery voltage falls below 3.4 V.

Battery Restore

Happens when the battery voltage rises above 3.7 V.

Panel Interconnection Fault

Happens when the terminal programmed as the Panel Interconnection Present input
is activated (see “Inputs/Outputs” on page 52).

Panel Interconnection Restore

Happens when the terminal programmed as the Panel Interconnection Present input
is deactivated (see “Inputs/Outputs” on page 52).

Cellular Receiver 1 Fault

Happens when the communicator is NOT able to communicate with receiver 1, over the
cellular channel: initialisation failure, supervision failure or receiver does not respond (see
“IP Receivers” on page 65).

Cellular Receiver 2 Fault

Like Cellular Receiver 1 Fault but for receiver 2.

Cellular Receiver 1 Restore

Happens when the communicator is able to communicate with receiver 1, over the cellular
channel: initialisation successful, supervision successful or receiver responds (see “IP
Receivers” on page 65).

Cellular Receiver 2 Restore

Like Cellular Receiver 1 Restore but for receiver 2.

Ethernet Receiver 1 Fault

Happens when the communicator is NOT able to communicate with receiver 1, over the
Ethernet channel: initialisation failure, supervision failure or receiver does not respond
(see “IP Receivers” on page 65).

Ethernet Receiver 2 Fault

Like Ethernet Receiver 1 Fault but for receiver 2.

Ethernet Receiver 1 Restore

Happens when the communicator is able to communicate with receiver 1, over the
Ethernet channel: initialisation successful, supervision successful or receiver responds
(see “IP Receivers” on page 65).

Ethernet Receiver 2 Restore

Like Ethernet Receiver 1 Restore but for receiver 2.

Table 11 - Description of events handled by communicator.
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Event Description

PSTN Fault Happens when the voltage on terminals LE is Tess than 2.5 V for the set LE Failure
Timeout (sec) (see “Timeouts” on page 68).

PSTN Fault Restore Happens when the voltage on terminals LE is more than 2.5 V for the set LE Restore
Timeout (sec) (See “Timeouts” on page 68).

GSM Fault Happens when the cellular signal is missing.

Cellular Network Fault The communicator can NOT connect to the cellular data network.

Cellular Network Restore The communicator can connect to the cellular data network.

Tamper Event Happens when tamper detection is enabled (see “Description of jumpers” on page 11)
and the communicator is opened or removed from the wall (versions with housing only).

Tamper Restore Happens when tamper detection is enabled (see “Description of jumpers” on page 11)
and the communicator is closed again or mounted to the wall (versions with housing
only).

FTC Fault Happens when an action fails (voice call, SMS, digital message).

FTC Restore Happens when the last action in the queue terminates successfully.

Periodic Call/SMS Happens when programmed (see “Communicator Options” on page 59).

Periodic Test Transmission Happens when programmed (see “Communicator Options” on page 59).

Antenna Fault Happens when the antenna is missing or the antenna has limited function (ANTLTE-02
only).

RF Jam Detected Happens when the communicator detects a jamming attack.

Ethernet DoS Detected Fault | Happens when the communicator detects a DoS? attack on the Ethernet channel.

Ethernet DoS Detected Restore |Happens when the communicator does NOT detect any DoS attack.

Ethernet Network Fault Happens when the communicator does NOT see the LAN network.

Ethernet Network Restore Happens when the communicator sees the LAN network.

Table 11 - Description of events handled by communicator.

a. Adenial-of-service attack (DoS attack) is a cyber-attack where the perpetrator seeks to make a machine or network
resource unavailable to its intended users by temporarily or indefinitely disrupting services of a host connected to
the Internet.

The installer can choose which protocol to use: Contact ID or SIA.

IS The selected protocol is also applied to events generated by the panel and sent to the phone numbers with the 1P Receiver
on GSM Path option enabled (see table on page 43).

To each event associated with the communicator's inputs, a specific Customer code can be assigned, while status events can
be assigned a unique user code.

The communicator handles a queue of 32 internal events. When the queue is full, further events are ignored.

The priority between internal and external events can be programmed by the installer (see “Priorities” on page 47).

For internal events, the times and manners in which they are sent are handled by the communicators: after a message is sent, the
unit waits for at most 1.25 seconds for the receiver to acknowledge reception (ACK). The unit will try to send a message up to
4 times.
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Operating Principles

The communicator can choose its primary channel (the factory setting is PSTN). It supplies the line and ringtone voltage for incom-
ing calls and decodes dial tones (DTMF). The simulated PSTN line provides a backup for the burglar alarm panel or other terminal
should the main PSTN line fail. Calls CANNOT be switched between PSTN and cellular, or vice-versa, while they are in progress.
Operating priority (as programmed) determines how the communicator handles SMS and voice messages, and calls with devices
connected to terminals LI (for example, a burglar alarm panel).

I The communicator is NOT able to decode pulse dialing.

To prevent undesired use of the simulated line via cellular, the device generates a double beep during voice calls. It does so
after 5 minutes and every 30 seconds thereafter.

PSTN channel

If the voltage on the PSTN terminals (LE) falls below 2.5 Vdc (+ 20%) for 10 to 3600 seconds (programmable value), the devices
connected to terminals LI are switched to the cellular network. When PSTN service is restored, the communicator switches back
to the PSTN line, again after a programmable delay.

I |tis possible to force communications to the cellular data network, even when PSTN is present, by entering a programmable

prefix (factory setting “9999”) ahead of the phone number dialled by the panel (for further details, see Dialing Prefix in
“PSTN/PTM" on page 68).
If the device is on the simulated PSTN line for any reason, the prefix is deleted from the number (if present).

Number dialled by Phone line Number with IP Receiver Effect
panel on GSM Path enabled

0123456789 PSTN None PSTN voice call to 0123456789.

99990123456789  |PSTN 0123456789 Contact ID call on cellular data network.

99990123456789  |PSTN None Voice or Contact ID call on cellular channel to
0123456789.

99990123456789 | Simulated PSTN 0123456789 Contact ID call on cellular data network.

99990123456789 | Simulated PSTN None Voice or Contact ID call on cellular channel to
0123456789.

I The communicator makes independent calls only on the cellular channel, and not on the PSTN line. All communications made

on the external PSTN line (terminals LE) come from the line connected to terminals L1, and are not modified. It follows that
the PSTN line connected to LE is not considered a communications channel pursuant to EN 50136.

Cellular channel

This provides the devices connected to the LI terminals with a simulated PSTN line if cellular reception is detected. If there is no
cellular coverage, it switches to PSTN.

Ethernet channel
If the communicator's Ethernet interface is connected to a LAN or WAN you can:

» decode the digital messages, coming from the control panel connected to the communicator, and forward them to an IP
receiver, over Internet;

> send the communicator's digital messages to an IP receiver, over Internet;

» downloading and uploading the communicator’s options locally via LAN and remotely via WAN.
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Contact ID and SIA transmission sequence on cellular and Ethernet channel

If the PSTN is missing, or the PTM (Panel Transmission Monitoring) is enabled (see “PSTN/PTM" on page 68), the communicator
may forward the Contact ID and SIA messages of the control panel connected to the LI terminals of the communicator, to the PSTN
receivers, over the cellular channel, or to IP receiver, over the cellular or Ethernet channel, if CID/SIA Event Conversion is
enabled (see “Phonebook” on page 43).

1. When an event occurs, the control panel engages the phone line: the communicator simulates the dial tone.

2. The control panel dials the number of the PSTN receiver: make sure that the control panel inserts at least a 1 second pause
or checks for the dial tone before dialling the number.

3. The communicator sends the handshake tone required for Contact ID or SIA.

The control panel transmits the message after it has received the handshake.

5. The communicator forwards the message over the cellular channel to the PSTN receivers or, if enabled, it decodes and
transforms the message into a data packet and sends it to the IP receivers via the cellular or Ethernet channel.

6. The receiver recognises the message and sends an acknowledgement (kiss-off) to the communicator, which forwards the
kiss-off signal to the control panel.

7. After the communicator has generated the kiss-off signal, if no other messages are to be sent, the control panel hangs up,
otherwise sends the next event.

SMS message transmission

>

The communicator may send SMS messages (max. length 70 characters) to previously programmed numbers (up to 8 of the num-
bers in the communicator's phonebook) when the events listed in table 11 on page 25 occur and end.

I A SMS is sent when one of the event listed in table 11 on page 25 occurs, for which an SMS has been programmed and at
least one number has been assigned.

Voice message transmission

The communicator may send up to 3 pre-recorded voice messages to previously programmed numbers (up to 8 of the numbers in
the communicator's phonebook) when the events listed in table 11 on page 25 occur and end. Up to 150 voice messages can be
recorded, of up to 6 seconds each.

A voice call is made when an event occurs for which a voice message has been programmed and which has at least one phone
number. In this case, the communicator executes the procedure indicated below.

1. The communicator dials the number and makes the call via the PSTN channel, or via the cellular channel if the PSTN line is
missing.

2. The communicator checks that the number is not engaged and that there are no problems with the cellular network, if the
PSTN line is missing, before proceeding, otherwise it terminates the call and tries step 1 again, for the programmed number
of times (Repeat Call in par. “Communicator Options” on page 59), after which it concludes the call cycle. If the event
has been programmed to call multiple numbers, they are called in sequence. This prevents the system calling an occupied
number several times in a few seconds.

3. The communicator waits up to 60 seconds for the called number to answer. If the number answers, it goes to step 4,
otherwise it hangs up and tries step 1 again, for the programmed number of times (Repeat Call in par. “Communicator
Options” on page 59), after which it concludes the call cycle.

4. The communicator plays the message for the event: the call is terminated only after the message has been received, or the
called user presses =] on his phone, if the Call Confirmation option is enabled (see “Communicator Options” on
page 59).

If multiple events requiring different messages to be sent to the same number have occurred, the messages are played in se-
quence, each for the programmed number of Repetitions (see “Communicator Options” on page 59), during a single call, to
avoid calling the same number multiple times.

If, at the end of the call cycle, the event which activated the communicator is still active, the above procedure is not repeated.
The event which tripped the call cycle must first restore before a new cycle of calls is tripped.
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Priority handling

Table 12 lists the actions that the communicator can perform and their priority at default.

The priorities of the communicator’s actions can be set on the console (see “Priorities” on page 47).

. .| Programmable
Action Priority on t%e console
Sending the confirmation ring for communicator’s output activation. 1 Yes
Sending communicator’s Contact ID or SIA messages to PSTN receivers via cellular channel. 2 Yes
Sending communicator’s voice messages via cellular channel. 3 Yes
Sending communicator's SMS messages via cellular channel. 4 Yes
Sending communicator’s Contact ID or SIA messages to IP receivers via cellular or Ethernet 5 Yes
channel.
Sending communicator’s notifications to the app. 6 Yes
Forwarding voice, Contact ID, or SIA messages of the control panel connected to LI terminals, on the |7 Yes
cellular or Ethernet channel.
Handle incoming SMS. 8 No
Supervision over the cellular data network. 9 No

Table 12 - Action priorities - factory settings.

Notes

»  If the communicator is performing an action and another action of higher priority presents, the communicator interrupts the
lower priority action and queues it.

> After the higher priority action has been completed, the communicator tries again to perform the interrupted (queued) action.

»  If several actions of the same priority occur together, they are queued and performed in sequence.

» If communicator's voice messages have lower priority than panel messages, when a panel message presents while the
communicator is transmitting a voice message, the communicator hangs up and the panel takes over the line (pick up
detected); after the panel's message has been completed (hang up detected) the communicator tries again to transmit the
interrupted (queued) message.

»  If the communicator's voice messages have higher priority and a panel event occurs while a communicator voice message is
being sent, the communicator must provide the engaged signal to the panel and continue transmitting its messages.

» Communicator SMS have lower priority than control panel actions and the communicator's voice messages, but an SMS
cannot be interrupted while it is being sent.

»  The lowest priority is given to data packet transmission for supervision of communications with the IP receivers.

BGS-210/BGS-220/B3G-220/BLE-320 29



Pay as you go balance check

If programmed on the Console (see “Pay As You Go Balance” on page 48), you can check your balance on the prepaid SIM
card. Once enabled, the system can check the pay as you go balance in three ways:

1. Onthe Console (Status page, only via PC-Link or USB connection).

2. By SMS to request a response to the sender's number. The command must include the normal user PIN.

3. An SMS containing the service provider's pay as you go balance information is periodically sent to the first number in the
Phonebook. For all service providers which support pay as you go balance check with network commands, the query string
can entered with the Console.

I At the service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.
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Panel Transmission Monitoring (PTM)

Constantly controlling communications with the panel (PTM function) enables the communicator to send Contact ID or SIA mes-
sages via cellular or Ethernet channel if communications between the panel and the central station via the PSTN line fail. If pro-
grammed (on the Console, PSTN/PTM page), this function is only enabled when the PSTN line is connected to terminals LE
and is present.

I Pulse dialing detection is not supported.
When the PTM function activates, the PSTN fault event occurs.

The communicator checks the LE line and, once it has detected that the line is occupied by the panel, executes the following pro-
cedure:

» it decodes the dialled number (DTMF);
» if the decoded number has PTM enabled, the communicator check for the Kiss-Off signal (it acknowledges the reception of
the event sent from the panel to the central station).

The panel must make the call immediately: the time between picking up and making the call, programmed on the panel, must be
at least 2 seconds.

If the PTM All Numbers option is enabled (see “PSTN/PTM" on page 68) the communicator will check for the kiss-off for all
calls.
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Activating outputs

The communicator has terminals (T1, T2, T3, T4, T5 and T6) which can be programmed as inputs or outputs. The outputs can be
activated automatically, when certain programmed events occur (see “Inputs/Outputs” on page 52), or remotely, by sending SMS
message to the communicator, by caller recognition from preprogrammed numbers (see “Phonebook” on page 43), or by the a
mobile device running the ConnectAlarm app (see “App Type Output” on page 54).

Remote output activation/deactivation

I The cellular or Ethernet connection must be present for the outputs to be remotely activated or deactivated.
To enable this function, the output must be configured as a Reserved Output.
When terminals T1, T2, T3, T4, T5 and T6 are programmed as outputs, they may be controlled remotely via SMS and Caller ID.
The SMS is never saved to the device, but is deleted as soon as the command has been executed.
The number used to activate the outputs using Caller ID must NOT be concealed (it must NOT be a private number).
To avoid calls being forwarded to devices connected to terminals L1, we recommend the communicator is programmed with
the Black List Enabled enabled (Options > Dial Options) and White list disabled (Phonebook) for the numbers you
wish to use for this function, calls will be rejected in this way.

The Open-Collector outputs can be programmed as Bistable or Monostable:

> Bistable outputs are activated/deactivated with two separate commands;
» Monostable outputs stay active for the programmed Monostable Time On, after which they return to standby, or until
they are deactivated by SMS.

Each output can be programmed to return a confirm signal:
» apreviously programmed SMS, if the output was activated/deactivated via SMS;
» aconfirm ringtone, if Caller ID was used.

I |f Caller ID is used, the call hangs up automatically 12 seconds after the output is activated.
For further details on the Control String and User Code options used in the following paragraphs, refer to paragraphs

“Inputs/Outputs” on page 52 and “Options” on page 46.
Bistable outputs
Open Collector outputs configured to be bistable may be activated in two ways:

1. By sending an SMS consisting of the pound (#), the User Code, the Control String (Control String can not have initial
blank spaces) and the characters =ON*, as follows:

#User Code*Control String=ON* (example: #123456*HOMELIGHT=0ON*)

2. Using Caller ID: in this case, the output is activated without charge, since once the device has recognised the caller, it
activates the output without accepting the call.

I An OC output configured as bistable can ONLY be deactivated by an SMS composed of the pound (#), the User Code, the
Control String and the characters =OFF* using the following syntax:

#User Code*Control String=OFF* (example: #123456*HOMELIGHT=0OFF¥*)

I The 6 digit user code is factory set to 000000; to replace it, see “Changing the user code” on page 34.

Monostable outputs

OC outputs configured as monostable can be activated in 2 ways: by SMS and using Caller ID.
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SMS

Send an SMS composed of the pound (#), the User Code, the Control String (Control String can not have initial blank spaces)
and by the characters =ON*, =ON*TonU* or =OFF* using the following syntax:

#User Code*Control String=ON*
#User Code*Control String=ON*TonU*
#User Code*Control String=OFF*

The =ON*TonU* parameter sets the ON time from 1 to 86400 seconds, with a resolution of 1 second. The ON Time can be set
by means of the Communicator's Console software. Ton is the required value and U is the unit in hours (H), minutes (M) and

seconds (S), as shown in the following example:

SMS Example Effect
#123456*HOMELIGHT=ON* Bistable activation.

#123456*HOMELIGHT=ON** Activated as programmed.

#123456*HOMELIGHT=0ON*3600S* Active for 3600 seconds.

#123456*HOMELIGHT=ON*50M* Active for 50 minutes.

#123456*HOMELIGHT=0ON*3600* Activated as programmed, the invalid ON time parameter is ignored.
#123456*HOMELIGHT=ON*000S* Activated as programmed, the invalid ON time parameter is ignored.
#123456*HOMELIGHT=OFF* Deactivated.

I To activate the output with an SMS using the programmed settings, remove the parameter TonU and leave the characters **.

(Example: #9876*HOMELIGHT=0ON**).
If the monostable output is programmed incorrectly, the output will be activated for the Monostable Time On set in the
Console.

Caller ID

The output is activated free of charge, since after it has recognised the caller, the device activates the output without answering
the call.

I Monostable outputs return to standby after the programmed Monostable Time On.
The Monostable Time On can be set from 1 second to 86400 seconds, with a 1 second resolution.
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SMS Programming

In addition to the processes described in the paragraph “Remote output activation/deactivation” on page 32, it is also possible to
carry out other remote procedures through the transmission of various SMS messages.

Changing the user code

The default user code is 000000; to change it, send an SMS message consisting of the characters #CUC followed by the current
user code and the new user code between * characters, in accordance with the following formula:

#CUC*User code*New user code*

The device will send an SMS to confirm that the user code has changed.

IS" The new user code must be 6 digits long (0-9).

Enabling/disabling remote programming

Remote programming allows you to operate the Console over a network. To set the communicator's parameters remotely, you must
enable remote programming, either with the Console (see “Network Settings” on page 49), or with an SMS composed of the char-
acters #ERA followed by the User Code and ON enclosed in * as follows:

#ERA*User code*ON*
To disable remote programming, send the following SMS:

#ERA*User code*OFF*
The device will confirm with an SMS.
Changing the installer code

The 6-digit installer code is used to access the remote programming interface (see “Installer Authentication” on page 46). The
default installer code is 111111; to change it, send an SMS message consisting of the characters #CIC followed by the current
Installer code and the new Installer code between * characters, in accordance with the following formula:

#CIC*Installer code*New installer code*

I The new installer code must be 6 digits long (0-9).
If the EN50136 option is enabled, the installer must be authorised by the normal user for the installer code change to

take effect.

The device will send an SMS to confirm that the installer code has changed.

Changing the level 4 installer code

The default level 4 installer code is 222222; to change it, send an SMS composed of the characters #CMC followed by the current
Level 4 Installer code and the new Level 4 Installer code enclosed between *, as follows:

#CMC*Level 4 installer code*New level 4 installer code*

I The new level 4 installer code must be 6 digits long (0-9).
For the Level 4 installer code change to take effect, the Level 4 installer must be authorised by the installer.

The device will send an SMS to confirm that the level 4 installer code has changed.
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Pay as you go balance check

To check your pay as you go balance with an SMS, you can either use the Console (see “Pay As You Go Balance” on page 48)
or send an SMS composed of the characters #CCC followed by * and the user code, as follows:

#CCC*User code*
or #ICCC followed by * and the installer code, as follows:
#ICCC*Installer code*

IS You will receive an SMS with the pay as you go balance.
At the mobile service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.

If the EN50136 option is enabled, the installer must be authorised by the normal user for the command to work.
Checking the expiration date

To find out the expiration date of the SIM card with an SMS, send an SMS composed of the characters #EDC followed by * and
user code, as follows:

#EDC*User code*
You will receive an SMS with the expiration date.
Updating the expiration date

To update the SIM card's expiration date with an SMS, send an SMS composed of the characters #EDU followed by *, the user
code and the new date, as follows:

#EDU*User code*new date*
The date must have the format DD/MM/YYYY.

I |f an expiration date has NEVER been set on the Console, the expiration time is set to 10:00 AM.
If a date and time of expiration have been set with the Console and you then change the expiration date with an SMS using

the command #EDU, the expiration time is unchanged.
Checking the serial number

This command is used to check the communicator's serial number with an SMS composed of the characters #RID followed by *
and the user code, as follows:

#R1D*User code*
or #IRID followed by * and the installer code, as follows:
#IRID*Installer code*
The device will respond with the RID: 01234567.
Enabling the installer
To enable the installer to work with the device, the user must send a SMS composed of #ENI followed by the User code as follows:
#ENI*User code*

The device will confirm with an SMS.

IS The installer must be enabled only if the EN 50136 option is enabled; if not, the installer is always enabled.
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Disabling the installer

To disable the installer from working with the device, the user must send a SMS composed of #DSI followed by the User code as
follows:

#DSI*User code*

The device will confirm with an SMS.

I The installer is disabled automatically 12 hours after being enabled.
Disabling the installer also automatically disables the level 4 installer.

Enabling the level 4 installer

To enable the level 4 installer to work with the device, the installer must send a SMS composed of #ENM followed by the Installer
code as follows:

#ENM?*Installer code*
The device will confirm with an SMS.
The level 4 installer is automatically disabled after 12 hours.

Start a remote session

To start a remote communicator session, send an SMS composed of #SRS followed by the Console IP and the Console port
between *, as follows:

#SRS*Console IP* Console port*
where:

» the Console IP if the public IP of the PC in the format “AAA.BBB.CCC.DDD" (e.g. 37.207.123.181) or host/domain name
format (Fully Qualified Domain Name, e.g. “my_name.dyndns.org");
» the Console port is the IP port in the format “NNNNN" (a 5 digit number in the range 1 to 65535).

I You must set the router to which the Console's PC is connected to enable port forwarding from the Console port to TCP port

51004 (the port used locally by the Console, this is NOT editable): ask your network administrator or refer to the router's
instructions.

The APN specified in the Console Network Settings page will be used, or the one programmed for Receiver 1 (IP Receivers
page).

If no APN has been programmed (neither in the Network Settings page nor in the IP Receivers page), the SMS must specify
the connection as follows:

#SRS*Console IP*Console port*APN access point name*

In some cases, if the APN USERNAME (max 32 characters) and PASSWORD (max 32 characters) are set, the above string is
sufficient to initiate a session, otherwise the string must be modified as follows:

#SRS*Console IP*Console port*APN access point name*User name*Password*
Changing the account number for the cellular receiver

To change the account number sent to the cellular receiver, send an SMS composed of #ACNC followed by the Installer Code
and the Account number between *, as follow:

#ACNC*Installer code*Account number*
where:

» the Account number is a maximum of 10 digits.
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Changing the account number for the Ethernet receiver

To change the account number sent to the Ethernet receiver, send an SMS composed of #ACNE followed by the Installer Code
and the Account number between *, as follow:

#ACNE*Installer code*Account number*
where:

the Account number is a maximum of 10 digits.
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ConnectAlarm app

Using the ConnectAlarm app on an Andorid/iOS mobile device, you can:

>
>
>

Activate or deactivate the communicator’s outputs (see “App Type Output” on page 54);

Display the status of the communicator's input (see “App Type Input” on page 55);

Display text messages when the communicator's events occur and end (see SMS / Push Notifications in “Inputs and
Events” on page 60);

Display the Contact ID messages from the communicator (see Central Station Calls in “Inputs and Events” on page 60);
Display text messages for Contact ID and SIA messages of control panel connected to the communicator's LI terminals (see
SMS / Push Notifications in “CID/SIA Converter” on page 61);

Display the Contact ID messages from the control panel connected to the communicator's LI terminals (see All CID
Events to App Server in “App Server” on page 50).

The app deletes all event notifications related to a class (alarm, tamper, fault) when an event of that class restores. You can
see active events through the button for event display.

Setting up the ConnectAlarm app

2

SN A W

4

1.
12.
13.

On your mobile device, download the ConnectAlarm app from Play Store or Apple Store.

Open the ConnectAlarm app: the first time you open the ConnectAlarm app you must read and accept the End User
License Agreement and the Privacy Notice.

Enter the Server Address, connect.tycomonitor.com, and click OK.

Click Sign up.

Enter a valid E-mail address and click SIGN UP.

Enter the E-mail code you received at the e-mail address you have entered in previous step and click PROCEED.

Enter the password for your account and click PROCEED.

In the Panel name option, enter a name for the system where the communicator is part.

In the Panel Serial option, enter the communicator serial number on the communicator electronic board.

In the Master User Code option, enter the communicator's user code (see Options > User Authentication > User
Code in the console): default, 000000.

Click CONNECT.

In the PANELS LIST, select the system you have had just added.

Enter the communicator's user code (see Options > User Authentication > User Code in the console) and click
PROCEED: default 000000.

At this point the end user can manage the system, according to the installer setup.
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PC PROGRAMMING

You can program the communicator using the latest BOSS console software that you can download from www.bentelsecurity.com.

I Toinstall and run the console, you must have admin rights on the PC; we also recommend that you check the firewall settings

if you encounter problems during the installation procedure.

Proceed as outlined below.

1.
2.
3.

5.
6.

Install the console.

Run the console.

Select the user name and enter the password to enter the session: the factory setting uses the username admin and the
password is 1234.

Open the File menu and click on New Account to create a new account or open an account listed in the Start Page:
double click on the account to open it.

Setup the options (refer to the respective paragraphs for instructions).

Download the options to the communicator (refer to “Downloading and Uploading” on page 73).

IS To change the console's language, click on Tools > Edit Current User; select the language on the next page.

Description of the menus
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File menu

New Account: Creates a new account and assigns the factory settings to all parameters.
Account Group Maintenance: groups several accounts into a group.

Recent Files: selects an existing account.

Exit: Exits the program. You will be prompted to save any changes made to the current installation.
View menu

Start Page: equivalent to clicking on the Start Page tab.

Toolbar: opens the Account Group Maintenance field.

Operators Online: list of connected users.

Open Accounts: list of saved accounts.

Communication Jobs: lists the communication sessions; you can also click on & .

Recent Activity: list of recent activity.

Tools menu

Language Manager: modifies, imports/exports, creates new languages.

Bentel Operating Security Software 4.0 operator Maintenance: in this window, the administrator can modify his
password and set the password for a user (with possible functional restrictions—Edit Operator Roles) for the Console.
Modem Manager Configuration: sets the type of connection: PCLINK or COM port.

Edit Current Operator: see previous page for changing the Console language.

Backup/Restore Database: sets the database management options.

Recycle Bin: select the account and delete it.

Window menu

Close All Tabs: closes all open account tabs.

Start Page: equivalent to clicking on the Start Page tab.

Help menu

About BOSS: displays the Console version.

End User License Agreement: displays the text of the license agreement.

Updates: Check For Updates—Show Installed Updates—Manually Install Update.

Send Feedback: send a comment to the manufacturer
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Description of icons
@ Global Upload: displays the communicator's settings on the PC.

@ Global Download: once a new account has been programmed (or an existing account has been modified), sends the new
settings to the communicator.

[ﬂ Save: if you change the settings for the existing account, click on Save to save the new configuration.
ol Connect Only.

® Communicate Tags.

D’ Upload Event Log.

m Clear all tags.

Ag Disconnect When Complete.

IJ@ Programming/Audio Import/Export.

h Select User: displays only information relating to the Normal User, Installer or Level4 Installer.

Q Option Name Search: enter the name of the option to the left of the icon.

Icons present on all programming pages.
) .

Clear all tags for this group.
"EV Export.
2 .
~—— Restore all options to default.
O Restore all options to original.

9 Tag all for upload: select all page options for upload.

D Tag all for download: select all page options for download.

The following pages are available in the programming section.
ﬂ} Phonebook: the phonebook page.

o
o Options: options page.
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“* Firmware Update: the icon only displays when the Level 4 Installer is enabled and is updating the firmware in this page
(see icon Select User).

“* Network Settings: connection settings page

y
% Inputs/Outputs: programs the communicator's inputs and outputs.

e« . . )
Communicator: communicator programming page.

-ﬂ)

IP Receivers: programs all IP receiver options.

Voice Messages: voice message management page.

n re=

PSTN/PTM: configures the PTM function.

]

¥ Event Log: configures the event buffer.

[}
I~/ Status: communicator monitoring page.
If you wish to configure a new account, go to File > New Account.

To display the list of accounts in the database, select View > Start Page or click on Start Page. In this section you can delete
or recall the configuration for a given account as follows:

1. Right click on the account name.
2. Select Open to load the data from the database or Delete to delete the account and all its settings from the database.

To load an account, you can simply double-click on the account name.
You can also order the list alphabetically or by code by clicking on the header of the column in question.

All settings are available on the following pages. This chapter describes in detail the application's pages.

I Depending on your level of access (Normal User, Installer or Level 4 Installer) the settings pages will display differently.
Programming/Audio Import/Export

Button 'EV opens a window with the following functions.

Export Programming: click on this button to export the current settings from the Console to a USB key.

(%]

P
e

_— Import Programming: click on this button to import a communicator's settings from a USB key to the Console; the
“{5 settings may be those previously exported from a Console running on another PC, or from a communicator.

Export Audio: click on this button to export the voice messages from the Console to a USB key.

Import Audio: click on this button to import the voice messages from a USB key to the Console; the messages may
(G be those previously exported from a Console running on another PC, or from a communicator.
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Restore Factory Settings
To restore the communicator's factory settings, proceed as follows.

Shut off power to the communicator.

Short pins 1 and 4 of the PC LINK 15 connector and restore power.

All LEDs will turn on, and after a few seconds the green ones will turn off to indicate that the factory restore is in progress.
You can now remove the short connection between pins 1 and 4 of connector 15.

Hwn e

5. Once the procedure terminates, the LEDs A will flash to indicate that the PINs have been restored to their values; the
other LEDs remain off.

I Recorded voice messages are NOT deleted by the factory restore procedure. Voice messages can be deleted in the Console's
Voice Messages page.
The factory restore procedure may NOT be executed if the communicator is ONLY powered by its backup battery; you must
reconnect its primary power supply.
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Phonebook

You can save up to 32 phone numbers in this page.

IS |f the periodic pay as you go balance function has been programmed for the communicator's SIM card (see the Options page)
the answering SMS is sent to phone number #1.

O Label: enter an alphanumeric string of at most 16 characters.
O Phone Number: enter a phone number with the international dialing prefix in the format “+xxx” (e.g.: +39 for Italy). Up to
16 digits at most are allowed (the “+" counts as a character).

I The numbers in the phonebook are used to activate outputs, for the SMS communicator, the voice communicator, the
IP receiver and for PTM (Panel Transmission Monitoring).

O White List: if Black List Enabled option is enabled (see Options > Dialing Options) the communicator will forward
to devices connected to terminals LI (e.g. a burglar alarm panel or a telephone set) the calls coming from numbers with this
option enabled and will block calls coming from all other numbers, as explained by the following table.

Black List Enabled White List Operating Mode

Disabled Disabled Incoming calls from any number are forwarded to LI.

Disabled Enabled Incoming calls from any number are forwarded to LI.

Enabled Disabled Incoming calls from any number are blocked.

Enabled Enabled ONLY incoming calls from numbers with White List option enabled are
forwarded to LI; incoming calls from any other number blocked.

I This option affects ONLY calls over cellular channel; incoming calls to communicator's terminals LE are ALWAY'S forwarded
to terminals L1.

I Numbers having the White List option enabled must have Caller ID enabled otherwise the communicator blocks the call.

O Activate Output: click on [+] to select the outputs (1 =T1,2=T2,3=T3,4=T4,5=T5 and 6 = T6) to activate when the
communicator receives a call from the number in question. This function is independent of the White List and Black List
Enabled settings in Options > Dialing Options. To activate the output, Caller ID must be enabled, for the number in
question.

IS To activate the output, set terminal T1, T2, T3, T4, T5 or T6 as Output and enable Reserved Output option (see Inputs/
Outputs page).

O Output Activation Confirmation: check this box to receive a ring tone to confirm activation of the output.

I The ringtone will sound 1 minute after the output has been activated.

If the communicator is busy with another operation (for example, the cellular channel is busy with voice communications),
the ringtone will not be sent.

O PTM: enable this options to activate the “PTM" function for the number in question. Use this option to monitor the panel's
calls to a PSTN receiver's number (central station). Factory setting: disabled.

O CID/SIA Event Conversion: enables sending of messages by voice or SMS, by decoding the panel's CID/SIA packets
(see table 13 on page 44).
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O Virtual Receiver on GSM Path: if CID/SIA Event Conversion is enabled and the option IP Receiver on GSM
Path is disabled, this function forces the communicator to simulate a receiver (the communicator sends a handshake and
kissoff to the panel).

O IP Receiver on GSM Path: enables decoding of events transmitted by the panel to the phone number and the
transmission of events on the cellular network to IP receivers (central station).

Channel!

Communication
protocol?

CID/SIA
Event
Conversion

Virtual
Receiver on
GSM Path

IP Receiver
on GSM
Path

Effects

PSTN

No effect

Disabled

No effect

No effect

The panel's voice and digital messages (SIA and
CID) are forwarded to PSTN.

PSTN

SIA / Contact ID

Enabled

No effect

No effect

The panel's voice and digital messages are
forwarded to PSTN.

The digital messages are converted to voice or
SMS messages (as set in the Communicator >
CID/SIA Converter page) and forwarded on
cellular channel3,

Cellular

No effect

Disabled

Disabled

Disabled

The panel's voice messages are forwarded on
cellular channel?.

Cellular

Contact ID

Enabled

Disabled

Disabled

The panel's voice and digital messages (CID) are
forwarded on cellular channel®.

The digital messages (CID) are converted to voice
or SMS messages (as set in the Communicator
> CID/SIA Converter page) and forwarded

on cellular channel®.

Cellular

SIA / Contact ID

Enabled

Enabled

Disabled

The digital messages (CID or SIA) are converted
to voice or SMS messages (as set in the
Communicator > CID/SIA Converter page)
and forwarded on cellular channel®,

The communicator simulates a receiver by
supplying the handshake and kissoff messages.

Cellularor
Ethernet

SIA / Contact ID

Disabled

Disabled

Enabled

The digital messages (CID or SIA) are decoded
and forwarded on the cellular or Ethernet channel
to the IP receivers.

The communicator simulates a receiver by
supplying the handshake and kissoff messages.

Table 13 - Effects of the CID/SIA Event Conversion, Virtual Receiver on GSM Path and IP Receiver on GSM Path
options on the communicator's operation.
1) Refers to the communications channel used by the communicator.
2) See the Options page.

3) Only if the panel's communications protocol is compatible with that of the communicator.

4) SIA and CID messages may NOT be understood by the receivers due to distortion on the cellular network.
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C s CID/SIA Virtual |IPReceiver
ommunication )
Channel! P Event Receiveron | on GSM Effects
protoco Conversion | GSM Path Path
Cellular or [ SIA T Contact ID |Enabled Disabled Enabled The digital messages (CID or SIA) are decoded
Ethernet and forwarded on the cellular or Ethernet channel

to the IP receivers.

The communicator simulates a receiver by
supplying the handshake and kissoff messages.
The digital messages (CID or SIA) are converted
to voice or SMS messages (as set in the
Communicator > CID/SIA Converter page)
and forwarded on cellular channel®.

Table 13 — Effects of the CID/SIA Event Conversion, Virtual Receiver on GSM Path and IP Receiver on GSM Path
options on the communicator's operation.
1) Refers to the communications channel used by the communicator.
2) See the Options page.

3) Only if the panel's communications protocol is compatible with that of the communicator.

4) SIA and CID messages may NOT be understood by the receivers due to distortion on the cellular network.
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Options

IS" The Options page differs depending on the user's access level: normal user, installer, level 4 installer.

User Authentication
O Installer Code Enabled: the normal user uses this option to enable the installer for programming the communicator.

IS The installer need only be enabled if the EN50136 option is enabled.

The installer is disabled automatically 12 hours after being enabled.
Disabling the installer also automatically disables the level 4 installer.

O User Code: enter the normal user code here (at most 6 digits), for use, among others, in remotely activating the outputs.
Factory setting: 000000.

Installer Authentication

O Installer Code: enter the installer code here (6 digits). Factory setting: 111111.

O Level 4 Installer Code Enabled: the installer can enable the level 4 installer code for communicator firmware updates
here.

IS This option is disabled if the EN50136 option is disabled.

O EN50136: the installer can enable/disable the EN50136 option in this box.

IS To ensure conformity with EN 50136-2, the EN50136 option should NOT be disabled.

Level 4 Installer Authentication
O Level 4 Installer Code: enter the level 4 installer code here (6 digits). This code gives access to firmware updates and
Status page display. Factory setting: 222222.

Dialing Options
This section configures certain aspects of the phone numbers.

0 Dial Prefix: the number entered in this box is placed before any number dialled by the communicator over the cellular
channel. Enter the prefix (1 to 8 digits) or leave the field empty, if unused.

O Digits to Remove: if the communicator is connected to a phone switchboard, the phone numbers (programmed in the
panel) must be preceded by the switchboard number (normally a single digit). Since the switchboard number is not
necessary when calls are made to the GSM network, it must be removed from the number. Enter the number of digits that
form the switchboard number (e.g. if switchboard number is 01, enter 2 in the Digits to Remove option, as 2 numbers form
the switchboard number).

I The phone number must have at least two digits more than the number entered in Digits to Remove, otherwise the engaged
tone is generated.

Example:

1. Setthe Dial Prefix = 9999 and set Digits to Remove to 2 on the communicator.
2. Configure a voice call on the panel using the number 9999011234567890.
3. Activate the call on the panel.
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4. The communicator will send the call to the number 1234567890.

IS If the Digits to Remove option is enabled and the panel calls a number which has CID/SIA Event Conversion enabled

(see Phonebook), the phone number in the phonebook must match the one programmed on the panel (including prefix), in
order for the communicator to convert it.

O Black List Enabled: if enabled, the communicator forwards to devices connected to terminals LI, the calls coming from
telephone numbers with White List option is enabled ONLY (see “Phonebook” on page 43).

IS This option affect ONLY calls over the cellular channel; incoming calls to communicator's terminals LE are ALWAYS
forwarded to terminals L.

IS" The Black List function COMBINED with Activate Output on Caller ID delays call refusal by a few seconds. The

confirmation ring tone associated with Activate Output on Caller ID delays call refusal by a few seconds. If the call is refused
immediately, the output has not been activated.

O Tones: select the country of Communicator installation; the selected country will set adequately a series of parameters for
the proper working of the simulated telephone line.

0 Roaming Enabled: enables the communicator to connect to another mobile service provider when that of communicator's
SIM is not available.

IS Additional charges may apply.

Priorities
This options allows you to configure the communicator's actions priority.

O Dialer / LI Priority: defines the priority of the communicator actions (see Dialer Events Priority) and the LI
(messages transmitted by devices connected to the LI terminals, such as a burglar alarm panel).

Factory setting: Dialer High, LI low.

Dialer Events Priority: set the priority for the communicator's actions described as follow.

Digital Calls: Sending the communicator's Contact ID or SIA messages to PSTN receivers via cellular channel.
Push Application: Sending the communicator’s notifications to the app.

Ring: Sending the confirmation ring for communicator’s output activation.

Rx: Sending the communicator's Contact ID or SIA messages to IP receivers via cellular or Ethernet channel.
SMS: Sending the communicator's SMS messages via cellular channel.

Voice Calls: the Sending communicator's voice messages via cellular channel.

YVVYVYQ

Factory setting: 1:Ring; 2:Digital Calls; 3:Voice Calls; 4:SMS; 5:Rx; 6:Push Application.
Generic
This section sets the loudness of the communicator's speaker and microphone.

O Speaker Volume: set the communicator's speaker volume: change this setting if the panel connected to terminals LI of the
communicator is unable to decode the DTMF commands.

O Microphone Volume: set the communicator's microphone volume: change this setting if the user is unable to understand
the voice messages sent by the panel connected to terminals LI of the communicator or by the communicator itself.

IS A high microphone volume setting can corrupt the DTMF tones from devices connected to terminals LI, and make them
incomprehensible.

0 Enable Antenna Cut Detection: if enabled, the Antenna Fault event is tripped when the antenna is not present or in
short circuit.

BGS-210/BGS-220/B3G-220/BLE-320 47



O Enable Battery Detection: if enabled, the Battery Fault event is tripped when battery faults are detected.
Automatic Clock Adjust
The options of this section is for the automatic synchronisation of the communicator's clock.

O SIM Phone Number: enter the phone number of the SIM card in the communicator (up to 16 digits).

O Auto SMS: if enabled, the communicator updates the system date and time by sending an SMS to the number specified in
the SIM Phone Number option. Factory setting: enabled.

O IP Clock Adjust: if enabled, the communicator gets the date and time from the IP receiver 1, when configured and
connected. Factory setting: enabled.

IS |n order to ensure compliance with EN 50136-2, the Auto SMS and IP Clock Adjust options must be enabled.

Pay As You Go Balance

IS At the service provider's discretion, the prepaid SIM card pay as you go balance service may be suspended.

This section configures the system so that an SMS containing the service provider's pay as you go balance information is periodi-
cally sent to the first number in the Phonebook. Program the following options for a proper pay as you go balance request, depend-
ing on the service provider in question.

I Check with the SIM card provider for the methods and any charges for the available credit request.

Enquiry Type: select the type of request (none, SMS, Call, Service Command).

Enquiry Number: telephone number to call or to which an SMS message should be sent in order to request credit balance
information.

Balance Message: string used in the SMS requesting the balance using network commands.

Enquiry Interval: enter the interval within which the periodic SMS is to be sent with the balance information (if handled by
the operator). The interval is composed of the following values:

— Days, day of next send—select to send the next periodic SMS. The value runs from 0 to 364;

— Hours, time of next send—select to send the next periodic SMS. The value runs from 0 to 23.

SIM Expiration

O SIM Expiration Message: enables sending the SMS (user programmable) with the expiration data to the first number in
the phonebook.

O SIM Expiration Date: once the expiration date is set, the message is sent 30, 15, 7, 6, 5, 4, 3, 2 and 1 days prior to the
expiry date itself. Click on Now to set the PC's time.

oo OO

I The SMS is sent once every programmed day: if it fails, no further attempt is done.

Protocol Settings

0 Handshake Repetition: set the number of handshakes generated by the communicator and sent to the panel connected
to terminals LI. Range: 1 to 4.

O Communication protocol: select the protocol: Contact ID or SIA.

I Depending on this setting, the communicator will decode CID or SIA events from the panel connected to the LI ling; the setting
must be the same for all numbers handled by the communicator.
The installer must check that the mobile service operator works reliably with Contact ID on the cellular network, due to issues
with transmission quality.
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Network Settings

The Network Settings page is to setup the communicator for communication via cellular network or via Ethernet, with the console
or the app, as indicated following.

O Device ID: enter the communicator's serial number you can find on the communicator's electronic board.
Cellular Data
The options in the Cellular Data section are to setup the communicator for communication via cellular network.

In order to set up a cellular communication, the user must specify an APN, optionally a user name and password, provided by the
network operator, as indicated following.

O Remote Access: check this box to enable remote programming.

O Remote Access APN: access point name, up to 32 characters. This is generally supplied by the cellular network operator.
0 Remote Access User Name: some operators require user authentication; enter the user name in this field.

O Remote Access Password: enter the password in this field.

I See paragraph “Start a remote session” on page 36.

Ethernet
The options in the Ethernet section are to setup the communicator for communication via Ethernet, as indicated following.

O Obtain an IP address automatically: If this option is ENABLED the server or router the communicator is connected to
provides the communicator with the information required to connect to the sub-network it is part of: IP Address, Subnet
Mask, Default Gateway, DNS Server Address.

If this option is disabled the connection options should be set manually as described in the following sections. Factory setting:
enabled.

Q IP Address: Enter the IP address! to be assigned to the communicator: the network administrator will provide this
information. Factory setting: 192.168.0.101

I This option is locked if the Obtain an IP address automatically option is enabled.

QO Subnet Mask: Enter the sub-network mask? for the local sub-network: the network administrator will provide this
information. Factory setting: 255.255.255.0.

IS This option is locked if the Obtain an IP address automatically option is enabled.

QO Default Gateway: Enter the IP address for the local gateway3 that will be used by the communicator to connect to a PC
outside the LAN (Ethernet): the network administrator will provide this information. Factory setting: 192.168.0.1.

I This option is locked if the Obtain an IP address automatically option is enabled.

1. Annternet protocol (IP) address is a numerical label that uniquely identifies a device (host) connected to a com-
puter network that uses Internet Protocol as a communication protocol. An IP address basically performs two main
functions: it identifies a device on the network and consequently provides the path for it to reach another device on
the network.

2. The sub-network mask indicates the method used to define the given range for a host within an IP sub-network, in
order to reduce network traffic and assist in searching for and reaching a determined host with relevant sub-net-
work I[P address.

3. A gateway is a network device whose main function is to carry network data packets outside to a local network
(LAN); the hardware device that implements this task is usually a router.
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DNS Server Address: Enter the IP address for the DNS server: the network administrator will provide this information.
Factory setting: 8.8.8.8 (google).

This option is locked if the Obtain an IP address automatically option is enabled.

Ethernet speed configuration: Select the Ethernet interface speed for the communicator.
Automatic (factory setting);

10 Mbps, Half Duplex;

100 Mbps, Half Duplex;

10 Mbps, Full Duplex;

100 Mbps, Full Duplex.

App Server

The options in the App Server section are to setup the communicator for communication with the app over the cellular or Ethernet
channel, as indicated following.

a

a

vV VVvQd

IP address: This is the IP address of the app server set in factory. Change this IP address if required. It can be numeric or
literal value.

Ethernet Remote Port: This is the listening port used by the app server over the Ethernet channel. Change this port only
if required by the app server. In any case, it must be different from receivers’ remote ports and from Cellular Remote
Port. Factory setting: 1303.

Cellular Remote Port: This is the listening port used by the app server over the cellular channel. Change this port only if
required by the app server. In any case, it must be different from receivers’ remote ports and from Ethernet Remote Port.
Factory setting: 1304.

Eth/Cellular Local Outgoing Port: This is the outgoing port used by the communicator to communicate with the app
server. Zero means that the communicator automatically set this value. Enter a fixed value if the local network rules block
some outgoing port. If you enter a value different from zero, it must be different from the Eth/Cellular Local Outgoing
Port set for BOSS. Factory setting: 0.

Channel Priority: Select the channel used by the communicator for communication with the app server.

Cellular Only: the communicator uses the cellular channel for communication with the app server.

Ethernet Only: the communicator uses the Ethernet channel for communication with the app server.

Ethernet Primary, Cellular Backup: the communicator uses the Ethernet channel for communication with the app
server, and the cellular channel when the Ethernet communication is missing.

Factory setting: Cellular Only.

O All CID Events to App Server: If enabled, all the Contact ID events of the panel connected to the communicator are
forwarded to the app. Factory setting: disabled.

O Ethernet Init encryption key: This is the encryption key used on the first communication with the app server, on the
Ethernet channel. Change this encryption key only if required by the app server. Factory setting:
12345678123456781234567812345678.

O Cellular Init encryption key: This is the encryption key used on the first communication with the app server, on the
cellular channel. Change this encryption key only if required by the app server. Factory setting:
12345678123456781234567812345678.

BOSS

The options in the BOSS section are to setup the communicator for communication with the console, as indicated following.

a

a

Ethernet Local Incoming Port: Enter the incoming port on the communicator for the console connecting as client.
Factory setting: 3062.

Eth/Cellular Local Outgoing Port: This is the outgoing port used by the communicator to communicate with the
console. Zero means that the communicator automatically set this value. Enter a fixed value if the local network rules block
some outgoing port. If you enter a value different from zero, it must be different from the Eth/Cellular Local Outgoing
Port set for App Server. Factory setting: 0.
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O Outgoing Connect. Fallback to Cellular: if this option is enabled, the communicator tries the connection through
cellular network if the Ethernet connection fails. Factory setting: disabled.
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Inputs/Outputs

This page is used for setting the input/output modes, the output activation events, their standby polarity (NC or NO), the reserved
outputs, and the remote activation SMS strings for the reserved outputs.

a

VVVYVY

Template: you can set the communicator's inputs and outputs to manage control panels or appliances, through the
ConnectAlarm app (see “App Type Output” on page 54 and “App Type Input” on page 55). This menu has a list of pre-
sets suitable for managing specific control panels.

Custom: you can set all the inputs and outputs options as required.

PowerSeries: input and output options are set to manage a PowerSeries control panel.

PowerNeo: input and output options are set to manage a PowerNeo control panel.

Kyo32G: input and output options are set to manage the Kyo32G control panel.

Kyo0320: input and output options are set to manage the Kyo320 control panel. The control panel may be connected to the
communicator as shown in figure 6.

L] @a&a—a| T1
|12 | «&a=—a| T2

Ol =»——| T3

N o=—1H

O3 | »—»| T5H

04 | »—»| T6

rh rh

Figure 6 — Wiring diagram example for managing the Kyo320 control panel through the ConnectAlarm app. Note: In your

installation, the control panel terminals may be different.

Callout Description
Control panel.
B Communicator.
L1 Input that arms the control panel when connected to negative.
L2 Input that disarm the control panel when connected to negative.
01 Output floating when the control panel is disarmed, connected to negative when the control panel is
armed.
02 Output connected to negative when the control panel is in alarm status.
03 Output connected to negative when the control panel is in tamper status.
04 Output connected to negative when the control panel is in fault status.
+ Negative terminal.
O Input/output: double click on the input/output number to view the settings.
O Label: enter an alphanumeric string of at most 16 characters.
O I/0 Type: in this column you can program terminals T1, T2, T3, T4, T5 and T6 for the following modes:
— Input, select this mode to configure the terminal as an input line;
— Output, select this mode to configure the terminal as an open-collector output;
O Polarity: this option is used to program the output/input standby status:
— Normally Closed: the terminal is grounded (negative) when the input/output is at standby;
— Normally Open: the terminal is floating when the input/output is at standby.
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O Output: if set as output, double click on [+] to display the column relating to the event to program for the output. The check
mark indicates that the output in question will be activated when the event occurs. Click on the boxes to check/uncheck them.

I An output returns to standby when all the causes that tripped it are resolved, except for FTC fault, in which case it returns
to standby after a set delay (ON time).

I Programming events for an output implies that certain events relating to the output are disabled.

» Panel Interconnection Fault: if selected, the output is activated when the panel is not present.

» Jamming Detect: if selected, the output will be activated if the device is subject to radio disturbance (factory setting:
terminal T6).

» Antenna Fault: if selected, the output is activated if the antenna is not present or has limited function (only with ANTLTE-
02).

» Tampers: if selected, the output will be activated when tampering is detected: opening the cover, removal from the wall
(factory setting: terminal T4 on BGS-220/B3G-220/BLE-320 or T6 on BGS-210).

» PSTN Fault: if selected, the output is activated if the external phone line, connected to the LE terminals, fails (factory
setting: terminal T1 on BGS-220/B3G-220/BLE-320 or T4 on BGS-210).

» GSM Fault: if selected, the output is activated if cellular network coverage fails (factory setting: terminal T5).

» No Cellular Network: if selected, the output is activated when problems occur with the cellular network connection
(factory setting: terminal T2 on BGS-220/B3G-220/BLE-320 or T5 on BGS-210).

» IP Receiver Fail: if selected, the output is activated whenever a problem occurs with the IP receiver.

» FTC Fault: if selected, the output is activated when a phone action does NOT terminate successfully and returns to
standby when the most recent phone action terminates successfully.

» Ethernet DoS Detected Fault: if selected, the communicator activates the output when detects a DoS attack on the
Ethernet channel.

» Ethernet Network Fault: if selected, the communicator activates the output when does NOT see the LAN network.

» Power Fault: if selected, the output is activated when a power problem is detected.

> Reserved Output: if selected the output may be activated by Caller ID or SMS.

I |f the Reserved Output option is enabled, all other options are disabled.

»  Control String; in this option, enter the string (maximum 16 alphanumeric characters) to be sent by SMS when you wish to
activate/deactivate the corresponding output remotely. This function is available even if Caller ID is not enabled.

» Activation Confirmation: select the type of confirmation you want to receive when the output is activated: none, Ring,
SMS (NOT available when the Control String option is left blank) and Ring + SMS. If the output is activated by an SMS,
the activation confirmation will be sent by SMS (see table below).

SETTINGS EFFECTS
Black List White List Activation Call Forwarded Confirmation
Enabled Confirmation | (only if the communicator is switched to cellular channel) Ring

Disabled Disabled None YES NO

Disabled Disabled Ring NO YES

Disabled Enabled None YES NO

Disabled Enabled Ring NO YES

Enabled Disabled None NO NO

Enabled Disabled Ring NO YES

Enabled Enabled None YES NO

Enabled Enabled Ring NO YES
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O Type: normally the outputs, when activated, remain so until a deactivation command is received (Bistable), at which point
the output will revert to its standby status. If you wish the output to return to standby automatically after a set period of time,
select the option Monostable and set this time in the option Monostable Time ON next to it.

O Monostable Time ON: enter a value in seconds (1 to 86400 in 1 second steps) to indicate the time for which the output,
if monostable, remains active before returning to standby.

Input

When a T1, T2, T3, T4, T5 or T6 terminal is configured as an input, it can be programmed as Normally Open or Normally
Closed (see Polarity). The input is polled at least every 30 ms and, if its state remains stable for more than 300 ms, Input 1
Event is generated (for terminal T1).

The following options are available when programming the inputs:

» Panel Interconnection Present: if enabled, deactivation of the input generates the Panel Interconnection Fault
event and activating the input generates the Panel Interconnection Restore event.

» Dialer Block: if enabled, activating the input blocks the communicator and deletes the queue.

» Force Communication on Simulated Line: if enabled, activating the input switches from PSTN to cellular channel.

App Type Output
You can activate or deactivate the communicator's outputs through the ConnectAlarm app.
Use this menu to set how the app activates or deactivates the outputs.

» Not Used: the app cannot activate or deactivate the output.

&

» Arm/ Disarm: the ARM and DISARM : buttons can be used to activate and deactivate the output.

The output is set as Bistable and you must connect it to a control panel’s input that arms the control panel when activated, and
disarms the control panel when on standby:

You need a communicator input to receive the control panel’'s arming status: see Arm / Disarm. Status.
» Partial Arm 1: the button - -
output.

is used to activate the output. The button will have the same label you set for the

The output is set as Monostable and you must connect it to a control panel’s input that performs a partial arming each time it is
activated.

You need a communicator input to receive the partial arming status: see Partial Arm / Dis. St 1.

» Partial Arm 2: similar to Partial Arm 1 but for partial arm 2.
» Partial Arm 3: similar to Partial Arm 1 but for partial arm 3.
» Partial Arm 4: similar to Partial Arm 1 but for partial arm 4.

» Arm Only: the ARM - button is used to activate the output.

The output is set as Monostable and you must connect it to a control panel’s input that arms the control panel each time it is
activated.

You need a communicator input to receive the control panel arming status: see Arm / Disarm. Status.

» Disarm Only: the DISARM @ button is used to activate the output.

The output is set as Monostable and you must connect it to a control panel's input that disarms the control panel each time it is
activated.

You need a communicator input to receive the control panel arming status: see Arm / Disarm. Status.
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» Automation Btn.: if there is not an input set as Automation input, with the same label as the output in question, the
app will have buttons to activate or deactivate the output similar to the following example, in the Output page.

PGM 3
hd “\i\ ‘

T Output 3

Element Description

i Output icon.
™

PGM 3 |Output terminal.
Output 3 |Output label you set in the Label option.

The output is set as Bistable and you must wire it to switch on or off the required appliance: the output activates when you click
¢ . W
the button ; the output goes on standby when you click the button .

IS You do not know the output status.

If you want to know the output status, set a terminal as Automation Input and assign to it the same label as the output you want
to control. In this case the app will have a button to activate or deactivate the output similar to the following example, in the Qutput

page.

PGM1

Output 1 @

Element Description

Output icon.

PGM 1 |Output terminal.
Output 1 | Output label and input label you set in the Label option.

Off Output status.

The output activates when you click the button ¢ : the button changes to , the status changes to On, and the output icon

i
changes to

N
The output goes on standby when you click the button = : the button changes to , the status changes to Off, and the

output icon changes to
App Type Input
You can display the communicator's input status on the ConnectAlarm app.

This menu is for setting how the app shows the input state.
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>
>

Not Used: the app do not show the input state.
Arm / Disarm. Status: this input type can be used to display on the app the arming status of the control panel.

When the input is on standby, and there are not any partial arm/disarm status inputs active, the app shows the following informa-

tion:

When the input is active, the app shows the following information:

0 Partition 1
Disarm

e Partition 1
Arm

Connect this input type to a control panel’s output that signals the arming status.

>

Partial Arm / Dis. St 1: this input type can be used to display on the app the partial arming status of the control panel.

When the input is on standby, and there are not other partial arm/disarm status inputs, and arm/disarm status inputs active, the
app shows the following information:

When the input is active, the app shows information similar to the following example:

0 Partition 1
Disarm

Partition 1
Perimeter

In the above example, Perimeter is the input label you set in the Label option.

Connect this input type to a control panel’s output that signals the partial arming status.

>
>
>
>

Partial Arm / Dis. St 2: similar to Partial Arm / Dis. St 1 but for the partial arming status 2
Partial Arm / Dis. St 3: similar to Partial Arm / Dis. St 1 but for the partial arming status 3.
Partial Arm / Dis. St 4: similar to Partial Arm / Dis. St 1 but for the partial arming status 4.
Alarm Status:; this input type can be used to display the alarm status of the control panel.

When the input is on standby, and there are no tamper status and fault status inputs active, the app shows the following infor-
mation:

i@ Everything is OK

No active warnings
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When the input is active, the app shows information similar to the following example:

. DUALPATH INPUT | PANEL ALARM  3:00 PM

Unknown 1

In the above example, PANEL ALARM is the input label you set in the Label option.
Connect this input type to a control panel’s output that signals the alarm status.
» Tamper Status: this input type can be used to display the tamper status of the control panel.

When the input is on standby, and there are no alarm status and fault status inputs active, the app shows the following informa-
tion:

i@ Everything is OK

No active warnings

When the input is active, the app shows information similar to the following example:

A

B3 DUALPATH INPUT | PANEL TAMPER 3:01 PM
Unknown 1

In the above example, PANEL TAMPER is the input label you set in the Label option.
Connect this input type to a control panel’s output that signals the tamper status.
» Fault Status: this input type can be used to display on the app the fault status of the control panel.

When the input is on standby, and there are no alarm status and tamper status inputs active, the app shows the following infor-
mation:

i@ Everything is OK

No active warnings

When the input is active, the app shows information similar to the following example:

[E) DUALPATH INPUT | PANEL FAULT
DualPath Fault 1

In the above example, PANEL FAULT is the input label you set in the Label option.
Connect this input type to a control panel’s output that signals the fault status.

» Automation input: This input can be used to control the status of an appliance.
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If there is no output set as Automation Btn., with the same label as the input in question, the app will show the input status, on

the Output page, as in the following example:

PGM 4
Input 4
Element Description
Input icon when the input is in standby.
PGM 4 |Input terminal.
Input4 | Input label you set in the Label option
off Input status when the input is in standby
hk
™

When the input is active, the status is On and the input icon is

Wire this input type to control the status of the required appliance.
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Communicator

This

page configures the events transmitted by the communicator.

Communicator Options

Call Options

a

a

a
a

Call All Numbers: select this option to call all numbers set for a given event.

You can select: Voice Calls, CID: Over GSM, Voice Calls and CID: Over GSM and Disabled. If this option is not
selected, the communicator terminates the cycle of calls as soon one of them terminates successfully.

Call Confirmation: select this option to have the dialer wait for the remote user to confirm reception of the voice message,
otherwise the dialer will try sending the voice message again; the remote user can confirm by pressing =] on his phone
(for tone dialling phones only).

While listing to a voice message, pressing Jonthe phone keypad blocks both the current call and any queued calls as well.

In some cases the dialer may bad interpret the response of answering machines, mobile service operator courtesy messages
and so on, so we recommend leaving Call Confirmation enabled.

Repeat Call: this option is used to enter the number of attempts to be performed (up to a maximum of 8) if the call is not
successful.

Repetitions: enter the number of times the voice message is to be repeated (up to 8) when the called number answers.
Voice message Header: select the voice message the communicator will play at the begin of each voice call.

Periodic SMS and Voice

a

a

a

Periodic SMS/Call Send Interval: set the interval (Days and Hours) between two Periodic Call/SMS events.
Range: 0 to 365 days and 0 to 23 hours.

Periodic SMS /Call First Send: select the date and time for sending the first Periodic Call/SMS event.

The 24hr/12hr button allows you to select the time display format: 12 hour or 24 hour.

The Now button sets the PC's current time.

In order to ensure conformity with EN 50136-2, the Periodic SMS/Call First Send time must be set to 1 day, and this
function may not be modified. Factory setting: 1 day.

To set the options for Periodic SMS/Call First Send, enter the SIM Phone Number and enable Automatic Clock
Adjust options in the Options page.

Ring only for periodic event: with this option enabled, the system sends a 5 s ring tone instead of a periodic voice
message.

Periodic Call

a

a

SIA
a

Periodic Test Transmission Interval: set the interval (Days and Hours) between two Periodic Test Transmissions
events. Range: 0 to 365 days and 0 to 23 hours.

Periodic Test Transmission First Send: set the date and time of the first Periodic Test Transmission event.

The 24hr/12hr button allows you to select the time display format: 12 hour or 24 hour.

The Now button sets the PC's current time.

Date/Time on SIA packet: if enabled, the SIA packet will include the date and time.
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Inputs and Events

SMS / Push Notifications

This table specifies, for each event handled by the communicator, the SMS message to send to the numbers specified in the column
SMS Tel. Number, and to the app.

a

a

a
a

Event: this column lists the events for which a SMS message is to be sent: refer to “Internal events” on page 25 for a
description of the events.

Telephone Numbers: select the numbers to which an SMS is to be sent.

Double click on [+] to expand the column: a table will be shown to select up to 8 telephone numbers from Phonebook.
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.

Double click on [-] to collapse the column: a list of selected telephone numbers will be shown.

Push Notification: if enabled, the event sends to the app the message set in the SMS / Push Notification Text option.
SMS / Push Notification Text: enter the text to be sent when the event occurs (up to 70 characters).

Voice Calls

This table specifies, for each event handled by the communicator, the voice messages to send to the numbers specified in the col-
umn Telephone Numbers.

a

Telephone Numbers: select the numbers to which the event is to send a voice message.

Double click on [+] to expand the column: a table will be shown to select up to 8 telephone numbers from Phonebook.
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.

Double click on [-] to collapse the column: a list of selected telephone numbers will be shown.

Voice Messages: select the voice messages to be sent in response to the event: you can select up to three voice messages
per event (First Message, Second Message and Third Message); click on [...] to browse the list of messages; you can
select a pre-recorded message (see Voice Messages) or record a new one, or open a .wav file on the PC. The Header
column shows the message selected in Call Options > Voice Message Header.

Central Station Calls

This table specifies, for each event handled by the communicator, the digital messages to send to the numbers specified in the
column Telephone Numbers.

The communicator sends the Contact ID messages to the app when Customer code and Contact ID Identifier options are
different from zero, and Event Enabled option is different from Disabled.

O Event: this column lists the events for which a digital message is to be sent.

O Telephone Numbers: select the numbers to which the event is to send the digital message, when you have selected
Channel Type, CID: Over GSM.
Double click on [+] to expand the column: a table will be shown to specifies which numbers in the Phonebook are to be
used for sending digital messages (up to 8 numbers can be set).
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [-] to collapse the column: a list of selected telephone numbers will be shown.

I When you select Channel Type, CID/SIA: over Data Network, the events are transmitted to the IP receivers indicated
in the IP Receivers page.

O Customer code: enter the user code (4 hex characters).

I You can set a different Customer code for each Input Event, or a single Customer code for all other events.
DO NOT use the character “A” for Contact ID.
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O Contact ID Identifier: enter the Contact ID the communicator is to send for the event.

I" The communicator also sends the qualifier 1 when the event occurs and the qualifier 3 when it terminates, as required by the
Contact ID protocol.

IS" The communicator also sends the number of input that has triggered the event (the zone number): 01 for input 1, 02 for input
2, 03 for input 3, 04 for input 4, 05 for input 5, 06 for input 6.

O Event SIA Identifier: enter the SIA code the communicator is to send when the event OCCURS.

O Restore SIA Identifier: enter the SIA code the communicator is to send when the event TERMINATES.

O Event Enabled: select Disabled to NOT send the event; select Send Activation to send ONLY the event's occurrence;
select Send Restoral to send ONLY the event's restoral; select Send Activation and Restoral to send both.

O Channel Type: select CID: Over GSM to send the event with the Contact ID protocol using a voice call on the cellular
channel; select CID/SIA: over Data Network to send the event with the Contact ID or SIA protocol on the cellular or
Ethernet channel (the protocol will be the one selected in the Communication Protocol option in the Options page).

I Contact ID messages may NOT be understood by the PSTN receivers due to distortion on the cellular network. It is
recommended to select CID/SIA: over Data Network instead.

CID/SIA Converter

If the communicator detects that the panel connected to the LI terminals is dialing a number from the Phonebook with the option
CID/SIA Event Conversion enabled, it converts the panel's Contact ID or SIA message into a voice or SMS message,
as indicated in this page.

The following tables show the way the CID/SIA Converter subgroup options concur in building of SMS and voice message.

1 Labels/ SMS / Push Notifications Labels/Messages (5)
Messages
Activation or Users >
SMS Header Advanced > Activation or | SMS Header | Partitions SMS Header for Label or
2 user or SMS
for event Restore or for area > Label Header for zone Zones >
Advanced > Restore Label
3|7 16 7 16 7 16
Bentel Alarm Partition Warehouse |Zone Entrance
. Bentel Alarm end Partition Warehouse |Zone Entrance
Bentel Arming Partition Warehouse |User Brown
Bentel Disarming Partition Warehouse |User Brown

Table 14 — Conversion of Contact ID and SIA message to SMS: 1) option subgroup; 2) option; 3) SMS maximum length;

4) examples; 5) Contact ID only.
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1 Commu'mcator Voice Calls Labels/Messages (5)
Options
Activation or
9 Voice Message | Advanced > Activation or Partitions > Voice Message Users > Voic‘e Message or
Header Restore or Zones > Voice Message
Advanced > Restore
3 |6 seconds 6 seconds 6 seconds 6 seconds
Bentel Alarm Warehouse Partition Entrance Zone
. Bentel Alarm end Warehouse Partition Entrance Zone
Bentel Arming Warehouse Partition Brown User
Bentel Disarming Warehouse Partition Brown User

Table 15 — Conversion of Contact ID and SIA message to voice message: 1) option subgroup; 2) option; 3) voice message
maximum length; 4) examples; 5) Contact ID only.

Two setup modes are possible:

» the base setup allows you to convert digital messages to voice and/or SMS messages by setting up a small number of
options: messages will signal event activation and restore only.

» the advanced setup allows you to convert digital message details like event description and, for Contact ID protocol, the
involved partition, zone and user.

SMS / Push Notifications and Voice Calls

Base setup allows you to define general messages for Alarms, Tampers, Openings and Closings and System Troubles
event categories, as explained in the following paragraphs.

O Category: shows the event categories. Settings made for a category will be automatically copied into all the category
events, in the Advanced group.

I |f different settings for each event are required, the following options must be empty and the required settings shall be made
in the Advanced group.

O Telephone Numbers: select the numbers to which the event is to send a message.
Double click on [+] to expand the column: a table will be shown to select up to 8 telephone numbers from Phonebook.
Click on a check box to enable/disable sending of a message to relative telephone number, for required events.
Double click on [-] to collapse the column: a list of selected telephone numbers will be shown.

O Push Notification: if enabled, the event send to the app the text message set in the Activation and Restore options.

Header: shows voice message selected in Communicator Options > Voice Message Header. The communicator will play
this message at the begin of each voice call. It is generally used to identify the system.

I This option is available in Voice Calls group only.

O Activation: setup the message the communicator sends when an event in that category occurs.
O Restore: setup the message the communicator sends when an event in that category ends.

Advanced

This option group allows for the setup of different option for each event, over those explained in the base setup, as explained in the
following paragraphs.

O Event: shows the events the communicator can convert.
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O Contact ID Identifier: shows the default Contact ID code for the event. This option can not be modified.

IS This option is considered only if Contact 1D has been selected as Communication Protocol in the Options page.

I |f Contact ID codes differ from defaults have to be converted, you can set up to 10 custom event codes for events in the
Custom group you can find at the end of event group list.

O Event SIA Identifier: enter the SIA event code to be converted for the event verification.

O Restore SIA Identifier: enter the SIA event code to be converted for the event restore.

I The Event SIA Identifier and Restore SIA Identifier options have default values that have to be verified. Enter 00 if
conversion is not required.

=" The Event SIA ldentifier and Restore SIA Identifier option is considered only if SIA has been selected as
Communication Protocol in the Options page.

Labels/Messages

The Contact ID protocol sends information on users, zones and partitions of the events.

Options in this group allow for assignment to each user, zone and partition number a SMS and/or voice message used for the mes-
sage building during the conversion.

I Up to 128 user / zone / partition numbers in total can be converted.

IS SIA protocol also sends information on users, zones and partitions but they are NOT converted by this communicator. If SIA

is selected as Communication Protocol in the Options group, you can setup the SMS Header for event option ONLY.

SMS Header for event: enter the text you want at the begin of each SMS. Generally it is used to identify the system.
Valid entries: up to 7 characters.

Default: empty.

SMS Header for user: enter the text you want before the message set for user identification.
Valid entries: up to 7 characters.

Default: a comma.

SMS Header for zone: enter the text you want before the message set for zone identification.
Valid entries: up to 7 characters.

Default: a comma.

SMS Header for area: enter the text you want before the message set for partition identification.
Valid entries: up to 7 characters.

Default: a comma.

Users / Zones / Partitions

a

Send only if user is defined / Send only if zone is defined / Send only if area is defined: if disabled (default), a
digital message is converted even if its user / zone / partition number is NOT present into the conversion tables. In this case
the user / zone / partition information will be not present. If enabled, digital messages without user / zone / partition
information in the conversion tables will be NOT converted.

Add: select this button to add a user / zone / partition number to convert.

User Number / Zone Number / Partition Number: enter the number to convert.

Valid entries: from 0 to 999; 65535 to disable.

Default: 65535.
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O Label: enter a text useful for user / zone / partition identification.
Valid entries: up to 16 characters.
Default: empty.

O Voice Message: select a voice message useful for user / zone / partition identification.
Default: (none).

a Iﬂ’: select this button to delete relative row.
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IP Receivers

This page sets the options relating to the communicator's connection with compatible Sur-Gard System IP receivers.

(IS

=

Given possible delays in transmission on the cellular data network, depending on the activity of the network operator,

we recommend programming as high as possible the number of call attempts on the panel, and also setting a backup phone
number which will send the alarms to a PSTN receiver.

The communicator does NOT support the shutdown command by Sur-Gard receivers.

Receiver Options

0 Receiver Channel Priority: select the channel, and the priority, the communicator uses to communicate with the
receivers. Factory setting: Cellular Only.

O Fibro Account # (Cellular): enter the account number for the Fibro protocol over the cellular channel: when transmitting
events to IP receivers, the Contact ID and SIA are wrapped in the Fibro protocol and this requires its own account number to
identify the account which is sending the events.

Contact your central station for details. Factory setting: 0000FFFFFF.

IS You must assign a different account number to each communicator which transmits events to a given receiver.

O Fibro Account # (Ethernet): similar to Fibro Account # (Cellular) but for the Ethernet channel.
Contact your central station for details. Factory setting: 0000FFFFFF.

O DNIS: the communicator transmits the DNIS code inside the Fibro packet to enable the receiver to identify the device (hex
numbers from 00000 to FFFFF).

0 Encryption Enabled: if enabled the communicator encrypts all communications with the IP receivers to increase the
security of its data transmissions.

O Hold ACK in memory timeout: sets how long an IP receiver ACK (acknowledge) is kept in memory. Within this period of
time, if the communicator detects that the panel is attempting again to send a message to the IP receiver and the latter
acknowledges it (ACK), the communicator confirms reception directly to the panel with a kiss-off signal, without sending the
message again to the IP receiver. If set to 0 (factory setting) ACK's are not held in memory. It is worth setting a value greater
than 0 when the panel attempts to transmit each call only once and does not manage to receive the ACK from the IP receiver
on time. Range: 0 to 15 minutes. Factory setting: 0.

Receiver 1

O Functionality mode: select Primary (receiver 1 is enabled) or Not Used (receiver 1 is disabled, the programming of
receiver 2 will be ignored, CID/SIA event transmission is disabled).

O IP Address: enter the receiver's IP address. The address can be entered in the numeric format (e.g. 192.168.0.101) or host
and domain format (Fully Qualified Domain Name, e.g., host_name.domain_name.com).

O Remote Port: enter the UDP port receiver 1 is listening to. Range: 1 to 65535. Factory setting: 3061.

O Receiver 1 Local Port: for each receiver, the communicator uses a different UDP port. Range: 0 to 65535. If the local port is
0, the communicator uses a random port number in the range 1-65535. Factory setting: 3060 (3065 for receiver 2).

O APN (Cellular): enter the Access Point name. This is generally supplied by the cellular network operator.

I Make sure the APN is correct for access to the cellular data network, otherwise certain functions may be limited (contact your
phone operator for details).

O APN User Name (Cellular): some operators require communication authentication; enter the user name in this field if
necessary.

0 APN Password (Cellular): some operators require communication authentication; enter the password in this field if

necessary.
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O Supervision Enabled: if enabled, the communicator supervises communications with the receiver.

IS The supervision messages are not sent during voice calls (on cellular channel).

O Supervision Time (Cellular): set the supervision time for the cellular channel. Range: 60 to 65535 s, in 1 s steps.

IS |n order to ensure conformity with EN 50136-2 supervision must be enabled and the Supervision Time must be no more than
3 minutes.

O Supervision Time (Ethernet): similar to Supervision Time (Cellular) but for the Ethernet channel.
Receiver 2

The options for Receiver 2 are the same as those for Receiver 1, except for the differences described below.

I |f Functionality mode for receiver 1 is Not Used, you can NOT set the options for receiver 2: transmission of CID/SIA
events to the central station is disabled.

Functionality mode: if Functionality mode for receiver 1 is Primary, receiver 2 may be:

Not Used, receiver 2 is disabled, the communicator sends the CID/SIA to receiver 1 only (this mode is called “single mode”);
Backup, the communicator sends the CID/SIA messages to receiver 1 and, should it not be operational or reachable, sends
them to receiver 2 (this mode is called “Main + Backup”);

» Redundant, the communicator sends the CID/SIA to both receiver 1 and receiver 2 simultaneously and sends the ACK
(confirmation of reception) to the panel only if both receivers confirm reception (this mode is called “Redundant”).

v vQg
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Voice Messages

The Voice Messages page enables you to record and play back voice messages: refer to “Inputs and Events” on page 60, for
how to associate messages to events.

The voice messages can be recorded with a microphone connected to the PC, you can load pre-recorded messages from the PC
(hard disk, LAN, USB key, etc.) or you can import voice messages from another communicator, as described in paragraph “Pro-
gramming/Audio Import/Export” on page 41".

IS" The Console can import all type of audio files in the WAVE format (WAV).

Play button: press this button to play back a voice message.

@ Record button: press this button to start recording a new voice message.
Stop button: press this button to stop playing back or recording the current voice message.
Pause button: press this button to pause playing back or recording the current voice message.
Clear button: press this button to delete a voice message saved in the communicator.

& Open button: press this button to load a voice message from a PC resource (hard disk, LAN, etc.).

Save button: press this button to save a voice message to a PC resource (hard disk, LAN, etc.).

IS While a message is being recorded, a progress bar indicates the duration.
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PSTN/PTM

This page relates to the PSTN line and the PTM function (Panel Transmission Monitoring). The PTM function enables the commu-
nicator to forward calls on the cellular channel if communications between the panel and the receiver on the PSTN line fail.

I After 5 minutes of use of the cellular channel, the communicator will start using the PSTN line again for forwarding panel calls.

The PTM function considers communication to have failed when:

» itdoes not detect dialing, if the Check Dialing option is enabled (it checks that a number is actually dialled);
» it does not detect the kiss-off (the signal sent from the receiver when a communication terminates successfully).

If the PTM All Numbers option is enabled, PTM is executed when the panel dials any number, otherwise it only monitors the
dialling of numbers which have the PTM option enabled in the Phonebook.

Calls are forwarded on the cellular channel when the PTM Max Errors Before Takeover setting is reached.

Primary Path

O Primary Communication Path: if you set PSTN, the communicator uses the PSTN line as its primary channel and
switches to the cellular and Ethernet channels only when the PSTN fails or when the PTM function trips; if you select
Cellular and Ethernet, the communicator uses ONLY the cellular and Ethernet channels.

Timeouts
O LE Failure Timeout (sec): enter a time (10 to 3600 seconds) for which the phone line on the LE terminals can be absent
before the PSTN Fault event occurs.

I |f any phone devices are connected to the LI terminals, this time may increase up to a maximum of approx. 60 s.

O LE Restore Timeout (sec): enter a time (10 to 3600 seconds) for which the phone line on the LE terminals must be
present before the PSTN Fault Restore event occurs.

I To ensure conformity with EN 50136-2, the LE Restore Timeout (sec) option should not be modified. Factory setting: 10 s.

PTM

0 PTM Max Errors Before Takeover: the communicator switches to cellular channel when it detects this number of failed
attempts. Range: 1 to 4, 0 disables the option. Factory setting: 0 (disabled).

O PTM All Numbers: if enabled, PTM is executed when the panel dials any number, otherwise it only monitors the dialling
of numbers which have the PTM option enabled in the Phonebook.

I The PTM Max Errors Before Takeover option must be non-zero before you can modify the PTM All Numbers setting.

O Check Dialing: if enabled, the communicator considers a off-hook followed by a on-hook without any number being dialled
by the device connected to the LI terminals to be a failure. Factory setting: disabled.

I The PTM Max Errors Before Takeover option must be non-zero before you can modify the Check Dialing option.

Generic

O Dialing Prefix: when the communicator detects a number being dialled with the prefix in this setting, it sends the call to the
cellular channel, to the phone number without the digits indicated in this option, even if the PSTN in available. Factory setting:
9999.
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Event Log

The Event Log page displays the events logged by the communicator.
The communicator can save up to 2048 events: when the buffer is full, each new event overwrites the oldest, which is thus lost.

Each event indicates the date and time at which it occurred.

Symbols on the Event Buffer bar

U Click on this icon to load the new events the next time a Global Upload or Communicate Tags is run.
B Click on this icon to cancel the selection of events in the event buffer.

i Click on this icon to open a window for saving an . XML file of the events loaded in the Event Log page.

I The XML file can be viewed with Excel or a compatible application.

il
¥ Click on this icon to display the events in relation to the criteria indicated in the Events In and With Text options.

O Events In: select the events you wish to view: All Events, Today, Last 7 Days, Last 14 Days, Last 30 Days, Last

Year or Custom.
Select Custom to set a specific period of time.
O With Text: only events containing the specified text will display.
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Firmware Update

A Updating the firmware from 1.00 and 1.10 revisions to 1.20 revision and above, results in CID/SIA conversion settings
to be lost.

I Only the level 4 installer, when enabled by the installer, can run firmware updates.

The Firmware Update page updates the communicator's firmware, both locally (PC-Link or USB) and remotely (cellular data
network).

Click on Select Firmware File to select the update file.
If the firmware update does not terminate successfully, the communicator will continue using the old version.

The name of the firmware file has the format FWxxyyzz.bin where:

»  FW identifies the file as firmware;
»  xxis the higher revision number;
» yy s the lower revision number;
»  zzis the test revision number;

.bin is the extension for a binary file.
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Status

The Status page gives a range of information about the communicator, as indicated below.

When you select the Status page, the console automatically displays the Communicate Tags window to establish communica-
tions with the communicator; once it is, the Status page updates every 5 seconds

Device Information

The Device Details box shows information which may be requested by technical assistance.

The Network Status box shows information relating to the cellular network, as given below.

g OO OODOO

Options page have been set properly.

GSM Provider Name: indicates the name of the mobile phone operator.
GSM Signal Strength: gives the strength of the cellular signal.
Cellular: the type of network.

Best Operator: when no SIM is in the communicator, it shows the mobile operator with the best signal strength.

Last Credit Received: shows the SIM's credit updated to the last request made with the Request for PayAsYouGo
Balance button or as programmed in the Pay As You Go Balance section of Options page.

Last Credit Date/Time: shows the date and time of the last credit update.

Request for PayAsYouGo Balance: press this button to display the residual credit of the communicator's SIM card.

This function is only available with the local connection (PC-LINK or USB) and if the Pay As You Go Balance options in the

GSM
LED Normal operation Malfunction
GSM ready Green: the cellufar network is available and the Red: the communicator is not yet ready.
communicator is operating.
Radio ON Green: the radio module is on. Red: the radio module is off.
SIM OK Green: the SIM is properly functioning. Red: there is a problem with the SIM card: SIM not
present, SIM expired, PIN enabled on SIM.
Carrier OK Green: the operator is connected. Red: the operator has not been connected.
Signal OK Green: the signal strength is above the required  |Red: signal too low or no signal.
minimum.
Main board
LED Normal operation Malfunction
Power OK Green: main power (+V terminal) is above the Red: main power (+V terminal) is less than 10 V.
minimum threshold.
Battery OK Green: the communicator's battery (if any) is Red: the battery voltage is less than 3.4 V.
charged.
PSTN OK Green: the PSTN line (connected to the Red: the voltage on the LE terminals is less than

communicator's LE terminals) is available.

25V.

No Jamming

Green: no jamming.

Red: the communicator's function is being jammed
(sabotage).

Antenna OK

Green: the antenna ANTLTE-02 is connected and
working properly.

Red: the antenna ANTLTE-02 is connected but
NOT working OK (wire cut).
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Incoming Call: orange—the communicator is receiving a call.
Call In Progress: green—the communicator is engaged with a call.
Outgoing Call: orange—the communicator is making a call.
Radio Initializing: green—the radio is initialising.

pp Server

Cellular Status: like Cellular Status of Receiver 1 but for connection status with the app server, over the cellular
channel.

Ethernet Status: like Cellular Status of Receiver 1 but for connection status with the app server, over the Ethernet
channel.

Passthrough: not supported.

Receiver 1

vV VVvQd

>
a

Cellular Status: this LED shows the connection status with receiver 1, over the cellular channel, as given below.

grey: the options for receiver 1 have NOT been programmed;

orange: receiver 1 is connected but NOT initialised;

red: the options for receiver 1 have been programmed but the receiver is not initialised, has disconnected due to a problem,
is unable to connect or initialisation has failed;

green: receiver 1 is initialised and connected.

Ethernet Status: like Cellular Status but for connection status with receiver 1, over the Ethernet channel.

Receiver 2

a

Like Receiver 1 but for receiver 2.

Inputs

Shows input status: grey, standby input; green, active input.

Outputs

Shows output status: grey, standby output; green, active output.
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Downloading and Uploading

Once the options have been set up, they must be downloaded to the associated communicator, as follows.

To perform the downloading and uploading you must connect the communicator to the PC on which the console is installed.

IS Itis also possible to download and upload options using a USB key as described in “Operations with the USB key” on page 79.

Connecting the communicator to the PC

You can connect the communicator to a PC:

>
>
>
>
a
1

locally, via the PC-LINK serial port;

locally, via the USB serial port;

locally, via LAN net (request the Ethernet interface);

remotely, via the Internet, via cellular or Ethernet channel (the Ethernet channel requests the Ethernet interface);
Connecting via PC-LINK serial port

Connect the communicator PC-LINK serial port to a free RS232 serial port on the PC using the PC-LINK cable (accessory
item), as shown on Figure 7.

'UU i
,DE'; D]]a

G

Eﬂﬁ
Wﬂj

Figure 7— PC-LINK cable connection: A) RS-232 female connector, solder side B) insert the PC-Link cable properly.

2.

Select the PC serial port used for connection with the communicator, as follows:

- select Modem Manager Configuration from the Tools menu;

- select the PCLINK - COM1 connection;

- select the PC serial port where the communicator is connected to, from the Port menu;
—click OK.

Connecting via USB serial port

Be sure that the PST jumper is NOT present otherwise communicator programming and status view are NOT possible.

Connect the communicator USB serial port (17 on Figure 2) to a free USB serial port on the PC using the USB-5M cable
(optional) or an equivalent USB cable (USB A-A cable).
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Select the PC serial port used for connection with the communicator, as follows:

- select Modem Manager Configuration from the Tools menu;

- select the PCLINK - COM1 connection;

- select the PC serial port where the communicator is connected to, from the Port menu;
- click OK.

Connection via Internet (cellular or Ethernet)

To set up connection via Internet (cellular or Ethernet), do the as follow.

1=y

a ok w e

10.

(IS

11.

12.

If a Ethernet connection is available, the cellular channel is used just to start the connection, after that the communication
continues on the Ethernet channel.

Select the customer account properties (right click on the customer account's name, then Properties).
On the left of the Account Name window, select the communicator from Panels/Modules branch.

If you have not already done, enter the communicator's Device ID?, and set the EN50136 option as required.
Select Cellular (IP remote) from the Connection Type menu then click Add.

Select Cellular (IP remote)? from the communicator branch then enter the telephone number for the communicator in the
Panel Phone Number field, select required Connection Timeout3, and click Save.

Open the customer account and select Global Download @ Global Upload @ or Communicate Tags iy .
Select Cellular (IP remote) from the Connection Type menu, and enter the Access Code for the indicated User

Type.

You can disable the option Automatically Hangup when Finished to keep the connection live until you click the
Disconnect Immediately m button under the Disconnect When Complete ,é menu.

Click OK: the SMS Message Generator window displays.

Type the public IP address of the router to which the PC is connected in the option Public IP Address and the port to
access the console (BOSS External Port): ask the network administrator or see the router’s instructions.

If this is the first installation, press APN Settings and set the APN Name, User Name, and Password for mobile data
services (ask the operator of the mobile data service).

Make sure to type the correct APN for WAP access - otherwise some functions may be limited.

Prepare an SMS message as outlined in the SMS Message Generator window or scan the QR code shown in the same
window, then click OK: the console waits for the incoming connection.
Send the SMS to the communicator number before the Connection Timeout time expires.

After receiving the SMS message, if correct, the communicator opens a remote connection via cellular or Ethernet channel with the
console: at this point, options can be downloaded or uploaded, as outlined in the section “How to download and upload the options”
on page 75, and the communicator can be managed through the Status page.

(IS

On the router connected to the console PC, the forwarding port from the console external port to port 51004 (internal console
port, CANNOT be changed) must be configured: request router instructions from the network administrator.

Connection via LAN (IP)

1. Enter the communicator's serial number from the communicator's electronic board: you can find the same option in
the Network Settings option group.

2. When Save is pressed Cellular (IP remote) is replaced by the number entered in Panel Phone Number.

3. Connection Timeout is the time the communicator waits for a configuration SMS.
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To set up connection via LAN (IP), proceed as described below.

1. Connect the communicator's Ethernet port (31 in Figure 1) to the LAN network where the PC with the console is connected,

or directly to the PC with the console.

Select the customer account properties (right click on the customer account's name, then Properties).

On the left of the Account Name window, select the communicator from Panels/Modules branch.

Select IP from the Connection Type menu then click Add.

On the left of the Account Name window, select IP in the communicator branch.

Click AUTO Discovery: the table in the IP Detected section will show the communicators found on the LAN.

Select the required communicator from the IP Detected table: the IP Address of the selected communicator is copied in

the IP filed.

8. Align the option Port with the option Ethernet Local Incoming Port in Network Settings > BOSS, if you changed
the factory setting 3062.

9. Click Save.

No gk wn

At this point it is possible to download and upload options as outlined in the section “How to download and upload the options” on
page 75, and manage the communicator via the Status page.

O Notes for Internet connection (cellular or Ethernet)
To download and upload options via Internet (cellular or Ethernet):

the PC on which the console is installed must be connected to the Internet;

the PC must have a public IP address and a public port for incoming connections to the console;

the firewall and the router must allow the PC to connect the public port to port 51004 of the console;

the communicator’s options must be set as described in “Network Settings” on page 49;

a SIM card must be inserted in the communicator and the credit on the SIM must be sufficient for cellular data services.

How to download and upload the options

VVVVY

Once you have set up the connection, you can download and upload the options as follow.

=" Downloading is the operation that transfers data from PC to communicator. Uploading is the operation that transfers data from
communicator to PC.

1. Either select the options to download and upload by enabling the relative downloading or uploading tabs U or jump to the
next step to download or upload ALL the options (global downloading or uploading):

» thetag ( U ) means that the relative option neither will be uploaded nor downloaded;
> the blue tag (E) means that the relative option will be uploaded;
» thered tag ( E)) means that the relative option will be downloaded.

I Modified options are automatically marked for uploading.

You can enable all the group options to be uploaded or downloaded by clicking on the 9 or O icon.

=

You can clear all the group option tags by clicking on the icon on the group toolbar.

You can clear option tags of all groups by clicking on the icon & on the main toolbar.
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2. Either click on the icon Ca to start the downloading and uploading of the selected options or click on the @ or @ icon
to download or upload ALL the options.

I Global downloading does not download voice messages and the voice message labels. Global uploading does not upload

voice messages, the voice message labels and event log?.

The application shows the Communicate Tags, Global Download or Global Upload window.

3. Select the Connection Type.

4. Ensure the Access Code is the same as the User Code, Installer Code or Level 4 Installer Code set in the Options
group (factory setting, respectively 000000, 111111, and 222222) and the Device ID is correct (see “Network Settings” on
page 49).

5. Click OK.

1. The event Log can be uploaded from the Event Log page.
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APPENDIX

Conformity with EN 50136-2:2013

To be compliant with EN50136-2:2013, the communicator must be configured and connected to a burglary alarm panel in one of
the two following ways (A and B) only:

A) PSTN connection (the panel must monitor the receiver's response directly via PSTN)

PSTN: The communicator's LI terminals are connected to the panel's external phone line terminals.

Terminal T4, configured as the Tampers output, is connected to a panel input (models with plastic housing only).

Terminal T5, configured as the GSM Fault output, is connected a the panel input.

Terminal T3 configured as Panel Interconnection Present input, is connected to the panel signal, to report that the panel
is present, or phone line present signal.

» Terminal T6, configured as IP Receiver Fail, is connected to the panel's jamming input.

YV V VYV

I |n the communicator's programming page IP Receivers—specify an IP receiver.

B) no PSTN

» Terminal T4, configured as the Tampers plus Jamming Detect output, is connected a the panel input (models with plastic
housing only).

» Terminal T5, configured as the GSM Fault output, is connected a the panel input.

» Terminal T1, configured as the alarm/tamper input, is connected to the panel's intrusion alarm/tamper output.

IS Input 1 Event is used to send the intrusion alarm code.

» Terminal T2, configured as an input, is connected to the panel's fault output.

IS |nput 2 Event is used to send the fault code.

» Terminal T6, configured as IP Receiver Fail output, is connected a the panel's input.

» Terminal T3 configured as Panel Interconnection Present input, is connected to the panel signal, to report that the panel
is present.

» The communicator's earth terminal must be connected to a panel input, to detect the connection between the panel and the
communicator.

I |n the communicator page Central Station Calls, for the two events Input 1 Event and Input 2 Event, set a Customer
Code and set Channel Type to CID/SIA: over Data Network. In the IP Receivers page, specify an IP receiver.

See the following tables.

Communicator Panel

O €

T1: PSTN Fault output
T2: No Cellular Network output

Table 16 — Connection scheme A: simulated PSTN.
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Communicator Panel
> T3: Panel Interconnection Present input € LE detection output
c
§ T4: Tampers output - Communicator tamper input
S T5: GSM Fault output - Cellular fault input
Q
& [T6: IP Receiver Fail output > 3 IP receiver communications failure input
Table 16 — Connection scheme A: simulated PSTN.
Communicator Panel
T1: Alarm/Tamper input € Alarm/Tamper output
T2: Fault input €« Fault output
2|T3: Panel Interconnection Present input €« Interconnection present output
?0; T4: Tampers plus Jamming Detect output - Communicator tamper input
S -
L‘% T5: GSM Fault output - Cellular fault input
T6: IP Receiver Fail output - IP receiver communications failure input
Earth terminal - Earth terminal

Table 17 - Connection scheme B: without simulated PSTN.

I The following must be configured: an event for sending the alarm/tamper Contact ID, in case of activation of input 1, and an
event for sending the fault Contact ID in case of activation of input 2.
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Operations with the USB key

I The USB can ONLY be used if the communicator is in USB Host mode (see “Description of jumpers” on page 11) and the
EN50136 option is disabled (see “Options” on page 46).

The USB key allows you to:

update the communicator's firmware;
export/import the communicator's settings;
export/import the communicator's voice messages;
export the communicator's event buffer;

Load custom defaults into the communicator.

VVVVY

When a USB key is inserted into the communicator's USB port, the folder structure in figure 8 is created (marked with the symbol ).

—| I~ B_FW |—| EJ FWxxyyzz.bin |
— 77BDEF [— (I defaultshin |
eprog001.bin
— ~B_PROG exportit |
£ EXPORT |{—— ] eprog002.bin |
import.txt
eprognnn.bin
7~ 55555588
eprog001.bin
£~ IMPORT {—— ] eprog002.bin |
eprognnn.bin
eaud001.bin
— 7~ B_AUDIO exportixt |
£ EXPORT [ 7 eaud002bin |
import.txt
7~ $555558S
eaud001.bin
£~ IMPORT [ ] eaud002bin |
eaudnnn.bin
— 7B.L0G 2 log.txt 5 elog00t.csv |

7 S8SSSSSS elog002.csv |

elognnn.csv

Figure 8 — File structure of a USB key used with the communicator.
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SSSSSSSS represents the communicator's serial number (8 hex digits), so that a single USB key can hold data for several different
communicators: each communicator will read/write to its own folder.

When a USB key is inserted into the communicator, the following procedure is executed:

1. Firmware update, if a valid firmware is in folder B_FW;

2. Communicator set with custom defaults, if defaults.bin is in the folder B_DEF (see “Loading custom defaults” on page 80 for
more details).

Communicator settings file export, if the file export.txt is in folder B_PROG;

Communicator settings file import, if the file import.txt is in folder B_PROG;

Communicator voice message export, if the file export.txt is in folder B_AUDIO;

Communicator voice message import, if the file import.txt is in folder B_AUDIO;

Communicator event buffer export, if the file log.txt is in folder B_LOG;

Firmware Update

This operation updates the communicator's firmware from a USB key.

No gk w

1. Download the firmware from the site www.bentelsecurity.com.
The name of the firmware file has the format FWxxyyzz.bin where:

» FW identifies the file as firmware;

»  xxis the higher revision number;

» yyis the lower revision number;

»  zzis the test revision number;

» .bin is the extension for a binary file.

I DO NOT rename the firmware file, otherwise the communicator will not recognise it.

2. Copy the firmware into folder B_FW on the USB key.
3. Insert the key into the communicator's USB port.

If the communicator finds an invalid firmware in folder B_FW, the ACT LED will flash slowly and the event Firmware Upgrade
failed - System is logged to the event buffer.

If the communicator finds a valid firmware in folder B_FW, which is also different from its current firmware, it will install it.

I |f more than one firmware file is in folder B_FW, the communicator will install the one with the highest revision number.

If folder B_FW contains a firmware which is less recent than the current one installed on the communicator, it is installed
anyway: firmware updates allow you to install a more recent firmware or restore an older one than currently installed on the
communicator.

At the end of the process the communicator reboots and logs the event FW upgrade done - System.
in the event buffer.

Loading custom defaults
To load custom defaults from a USB key, complete the following steps.

1. Create the folder B_DEF on the USB key, if it is not already there.
2. Copy the settings file to the B_DEF folder: the settings file may be created as described in the export procedure, or on the
Console.

I The export procure and the console generate the file eprognnn.bin, where nnn is an index from 001 to 999. You must rename
the file to defaults.bin before coping it in the B_DEF folder.

3. Delete the B_PROG/import.txt file, if present.
4. Insert the USB key into the USB port of the communicator.
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5. Close the PST and USB jumpers.
6. Perform the factory setting restore as indicated in “Restore Factory Settings” on page 42.

The communicator is programmed as specified in the defaults.bin file; it then reboot.

I Do not remove the USB key until the communicator reboots.

After the communicator reboots, you can set the PST and USB jumpers as required.

IS You can import the default settings in any communicator because the defaults.bin file is independent form the communicator
that has generated it.

Exporting settings
This operation exports the communicator's settings to a USB key.

1. Create the folder B_PROG on the USB key, if it is not already there.
2. Create a new text file in folder B_PROG and call it export.txt.
3. Insert the USB key into the communicator's USB port.

The communicator will export its settings to B_PROG\SSSSSSSS\EXPORT\eprognnn.bin, where:

» SSSSSSSS is the communicator's serial number;
» eprog is the prefix for a communicator settings file;
» nnnis an index from 001 to 999;

» .bin s the extension for a binary file.

In the EXPORT folder, the communicator will search for setting file with the highest index and create a setting file with that index
incremented.

If the EXPORT folder already has a settings file with index 999, exporting is not possible: the ACT LED will flash slowly and the
event USB Programming Export Failed - System is logged to the event buffer.

Importing settings
This procedure imports settings from a USB key.

1. Create the folder B_PROG on the USB key, if it is not already there.

2. Create a new text file in folder B_PROG and call it import.txt.

3. Create the folder SSSSSSSS in B_PROG, where SSSSSSSS is the serial number of the communicator to which you wish to
import the settings.

4. Create the folder IMPORT in the SSSSSSSS folder.

5. Copy the settings file to the IMPORT folder: the settings file may be created as described in the export procedure, or on the
Console.

6. Insert the USB key into the USB port of the communicator with the serial number SSSSSSSS.

The communicator will delete the file import.txt and will be programmed as specified in the imported settings file: it will then reboot
I You can import settings files ONLY if the originating communicator has the same installer code.

I |f folder B_PROG contains both the files export.txt and import.txt, the communicator will first export its current settings
(backup) and then import the new ones.

Exporting Voice Messages
This operation exports the communicator's voice messages to a USB key.
1. Create the folder B_AUDIO on the USB key, if it is not already there.
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2. Create a new text file in B_AUDIO and call it export.txt.
3. Insert the key into the communicator's USB port.

The communicator will export its voice messages to B_AUDIO\SSSSSSSS\EXPORT\eaudnnn.bin, where:

» SSSSSSSS is the communicator's serial number;

» eaud identifies the file as containing voice messages;
» nnnis an index from 001 to 999;

» .bin s the extension for a binary file.

The communicator will search EXPORT for the voice messages file with the highest index and create a new one with that index
incremented by one; if EXPORT already contains a file with the index 999, it will not export the file: the ACT LED will flash slowly
and the event USB Audio Export Failed - System will be logged to the event buffer.

Importing Voice Messages
This procedure imports voice messages from a USB key.

1. Create the folder B_AUDIO on the USB key, if it is not already there.

2. Create a new text file in B_AUDIO and call it import.txt.

3. Create the folder SSSSSSSS in B_AUDIO, where SSSSSSSS s the serial number of the communicator to which you wish to
import the messages.

4. Create the folder IMPORT in the SSSSSSSS folder.

5. Copy the audio file to the IMPORT folder: the settings file may be created as described in the export procedure, or on the
Console.

6. Insert the USB key into the USB port of the communicator with the serial number SSSSSSSS.

The communicator will import the voice messages.

I |f folder B_AUDIO contains both the files export.txt and import.txt, the communicator will first export its current audio
(backup) and then import the new messages.

Exporting the Event Buffer

This operation exports the communicator's event buffer to a CSV format text file (Comma Separated Value) on the USB key: the
CVS file can be viewed with Excel and Noteblock.

1. Create the folder B_LOG on the USB key, if it is not already there.
2. Create a new text file in B_LOG and call it log.txt.
3. Insert the key into the communicator's USB port.

The communicator will export its event log to B_LOG\SSSSSSSS\EXPORT\elognnn.csv, where:

» SSSSSSSS is the communicator's serial number;
» elog identifies the file as an event buffer;

» nnnis an index from 001 to 999;

» .csvis the file extension.

The communicator will search SSSSSSSS for the log file with the highest index and create a new one with that index incremented
by one; if SSSSSSSS already contains a file with the index 999, it will not export the file: the ACT LED will flash slowly and the
event USB Log Export failed - System will be logged to the event buffer.
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